
SITRANS F

Ultrasonic flowmeters
SITRANS FST020 IP65 (NEMA 4X)

Operating Instructions

7ME3570 - AC: 1HA400AA0 / 7ME3570 - 
DC:1HB400AA0

06/2024
A5E41425845-AD

Getting started 1
Introduction 2
Safety notes 3
Description 4
Installing/mounting 5
Connecting 6
Commissioning 7
Operating 8
Parameter assignment 9
Service and maintenance 10
Diagnostics and 
troubleshooting 11
Technical specifications 12
Dimension drawings 13
Replacement parts 14
Product Documentation 
and support A
Communication B
Remote Operation C
HMI menu structure D
Unit abbreviations and 
custom units E



Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger.

DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance 
are required to ensure that the products operate safely and without any problems. The permissible ambient 
conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens Aktiengesellschaft. The remaining trademarks in 
this publication may be trademarks whose use by third parties for their own purposes could violate the rights of 
the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions.

Siemens Aktiengesellschaft
Digital Industries
Postfach 48 48
90026 NÜRNBERG
GERMANY

Document order number: A5E41425845
Ⓟ 07/2024 Subject to change

Copyright © Siemens 2024.
All rights reserved
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Getting started 1
1.1 Getting started

Condition
You have read the following safety instructions:
• General safety information (Page 15)
• Basic safety information: Installing/mounting (Page 25)
• Basic safety information: Connecting (Page 29)
• Basic safety information: Commissioning (Page 39)
Read the entire document in order to achieve the optimum performance of the device.
The Operating Instructions describe the FST020 transmitter.
• For the installation of the FSS200 sensors go to: FSS200 Installation Manual (https://

support.industry.siemens.com/cs/ww/en/view/109803765).
• For the installation of the FSS100 sensors go to: FSS100 Installation Manual (https://

support.industry.siemens.com/cs/ww/en/view/109955728).
• For an overview of the menu structure go to: FST020 menu structure (https://

support.industry.siemens.com/cs/ww/en/view/109954689).

Procedure for wall mount enclosure with internal DSL
1. Install the transmitter.

Wall mount transmitter (Page 27)
2. For the FS220 system, mount the FSS200 sensors as described in the FSS200 Installation 

Manual (https://support.industry.siemens.com/cs/ww/en/view/109803765).
For the FS120 system, mount the FSS100 sensors as described in the FSS100 Installation 
Manual (https://support.industry.siemens.com/cs/ww/en/view/109955728).

3. Connect the transmitter.
Connecting (Page 29)

4. Start up the device.
Device startup (Page 42)

5. Select access level "Expert" to be able to configure all parameters.
Access control (Page 41)
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Introduction 2
2.1 Purpose of this documentation

These instructions contain all information required to commission and use the device. Read the 
instructions carefully prior to installation and commissioning. In order to use the device 
correctly, first review its principle of operation.
The instructions are aimed at persons mechanically installing, connecting and 
commissioning the device, as well as service and maintenance engineers.

2.2 Document history
The following table shows the most important changes in the documentation compared to each 
previous edition.  

Edition Note
06/2024 Support for SITRANS FSS100. Getting started chapter added. Updates in chapters: Descrip‐

tion - FS120 system overview, Commissioning, Operating, Device documentation packaging
05/2022 Firmware update, corrections regarding pulse output
09/2017 First edition

2.3 Product compatibility

Edition Remarks Device revision Compatible device revision integration package
06/2024 Updated with 

FSS100 support
Modbus
FW: 2.03.01
HW: 3.00.02 or later

SIMATIC PDM V9.2 SP2 or later EDD: 2.03.00 or later

05/2022 Firmware up‐
date

Modbus
FW: 2.01.00-04
HW: 3.00.02 or later

SIMATIC PDM V8.2 SP1 or later EDD: 1.00.00 or later

09/2017 First edition Modbus
FW: 2.01.00-04
HW: 3.00.02 or later

SIMATIC PDM V8.2 SP1 or later EDD: 1.00.00 or later

SITRANS FST020 IP65 (NEMA 4X)
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2.4 Device documentation package
The user documentation package for this product includes the following documents:

Document Purpose Intended users Availability
Operating Instruc‐
tions

Contains all information needed to 
• check and identify the delivered package
• install and electrically connect the prod‐

uct
• commission the product (setting param‐

eters via HMI menu)
• operate and maintain the device on a 

daily basis
• troubleshoot and remedy minor opera‐

tion interruptions

Instrument techni‐
cians, plant opera‐
tors

• Available for download from 
SIOS (https://
support.industry.siemens.co
m/cs/ww/en/view/
63102826)

Installation Manual Contains all information needed to
• Install and connect all sensors variants

Instrument techni‐
cians, plant opera‐
tors

• SITRANS FSS100 Installation 
Manual
Available for download from 
SIOS (https://
support.industry.siemens.co
m/cs/ww/en/view/
109955728)

• SITRANS FSS200 Installation 
Manual
Available for download from 
SIOS (https://
support.industry.siemens.co
m/cs/ww/en/view/
109803765)

Menu structure Contains 
• Descriptions of all parameters that can 

be accessed through the local display 
(HMI)

• Value ranges and default values
• Modbus registers, data types/size in 

bytes

Instrument techni‐
cians, plant opera‐
tors

• SITRANS FST020 menu struc‐
ture
Available for download from 
SIOS (https://
support.industry.siemens.co
m/cs/ww/en/view/
109954689)

2.5 Items supplied
The device is delivered as:

Introduction
2.5 Items supplied
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Wall mount enclosure
• FST020 transmitter wall mount enclosure
• Siemens Process Instrumentation disk con‐

taining certificates and manuals.

Note
Supplementary information
Supplementary product and production specific certificates are included on the SensorFlash® SD 
card in the transmitter socket. 

Note
Scope of delivery may vary, depending on version and add-ons. Make sure the scope of delivery 
and the information on the nameplate correspond to your order and the delivery note.

Note
The SD-Card Mass Storage functionality has been disabled by SIEMENS on all products sold or 
imported in the United States. Products having enabled SD-Card Mass storage functionality are 
intended to be used solely outside the United States and should not be imported into the United 
States by the user. SIEMENS expressly prohibits customers from using, importing, or buying 
products with the SD-Card Mass Storage functionality in the United States or performing any acts 
to enable the SD-Card Mass Storage functionality on products sold by SIEMENS with this feature 
disabled. 

NOTICE
Use in a domestic environment
This Class A Group 1 equipment is intended for use in industrial areas.
In a domestic environment this device may cause radio interference.

2.6 Checking the consignment
1. Check the packaging and the delivered items for visible damages.
2. Report any claims for damages immediately to the shipping company.

Introduction
2.6 Checking the consignment
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3. Retain damaged parts for clarification.
4. Check the scope of delivery by comparing your order to the shipping documents for 

correctness and completeness.  
WARNING

Using a damaged or incomplete device
Risk of explosion in hazardous areas.
• Do not use damaged or incomplete devices.

2.7 Security information
Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, systems, machines and networks.
In order to protect plants, systems, machines and networks against cyber threats, it is 
necessary to implement – and continuously maintain – a holistic, state-of-the-art industrial 
security concept. Siemens’ products and solutions constitute one element of such a concept.
Customers are responsible for preventing unauthorized access to their plants, systems, 
machines and networks. Such systems, machines and components should only be connected 
to an enterprise network or the internet if and to the extent such a connection is necessary 
and only when appropriate security measures (e.g. firewalls and/or network segmentation) 
are in place.
For additional information on industrial security measures that may be implemented, please 
visit 
https://www.siemens.com/industrialsecurity. 
Siemens’ products and solutions undergo continuous development to make them more 
secure. Siemens strongly recommends that product updates are applied as soon as they are 
available and that the latest product versions are used. Use of product versions that are no 
longer supported, and failure to apply the latest updates may increase customer’s exposure 
to cyber threats.
To stay informed about product updates, subscribe to the Siemens Industrial Security RSS 
Feed under 
https://www.siemens.com/cert. 

Introduction
2.7 Security information
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2.8 Transportation and storage
To guarantee sufficient protection during transport and storage, observe the following:
• Keep the original packaging for subsequent transportation.
• Devices/replacement parts should be returned in their original packaging.
• If the original packaging is no longer available, ensure that all shipments are properly 

packaged to provide sufficient protection during transport. Siemens cannot assume liability 
for any costs associated with transportation damages.
NOTICE
Insufficient protection during storage
The packaging only provides limited protection against moisture and infiltration.
• Provide additional packaging as necessary.

Special conditions for storage and transportation of the device are listed in Technical 
specifications (Page 97).

Identification   

Note
IMPORTANT
This device is NOT to be used in hazardous areas.
CE declaration is delivered with the device.

Transmitter model number is: FST020
The system ordering code represents the transmitter including accessories.
AC System ordering code: 7ME3570-1JA4XXXXXX
DC System ordering code: 7ME3570-1JB4XXXXXX
AC - Transmitter ordering code: 7ME3570 - 1JA40-0AA1
DC - Transmitter ordering code: 7ME3570 - 1JB40-0AA1

2.9 Further Information

Product information on the Internet     
The Operating Instructions are available on the documentation disk shipped with the device, 
and on the Internet on the Siemens homepage, where further information on the range of 
SITRANS F flowmeters may also be found:
Product information on the internet (http://www.siemens.com/flow) 

Introduction
2.9 Further Information
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Worldwide contact person   
If you need more information or have particular problems not covered sufficiently by these 
Operating Instructions, get in touch with your contact person. You can find contact information 
for your local contact person on the Internet:
Local contact person (http://www.automation.siemens.com/partner) 

2.10 Notes on warranty
The contents of this manual shall not become part of or modify any prior or existing agreement, 
commitment or legal relationship. The sales contract contains all obligations on the part of 
Siemens as well as the complete and solely applicable warranty conditions. Any statements 
regarding device versions described in the manual do not create new warranties or modify the 
existing warranty.
The content reflects the technical status at the time of publishing. Siemens reserves the right 
to make technical changes in the course of further development.

Introduction
2.10 Notes on warranty
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Safety notes 3
3.1 Preconditions for safe use

This device left the factory in good working condition. In order to maintain this status and to 
ensure safe operation of the device, observe these instructions and all the specifications relevant 
to safety.
Observe the information and symbols on the device. Do not remove any information or 
symbols from the device. Always keep the information and symbols in a completely legible 
state.

Symbol Explanation
Consult operating instructions

     

3.1.1 Improper device modifications

WARNING
Improper device modifications   
Risk to personnel, system, and environment can result from modifications to the device, 
particularly in hazardous areas.
• Only carry out modifications that are described in the instructions for the device. Failure to 

observe this requirement cancels the manufacturer's warranty and the product approvals. 
Do not operate the device after unauthorized modifications.

3.2 Laws and directives
Observe the safety rules, provisions and laws applicable in your country during connection, 
assembly and operation. These include, for example:     
• National Electrical Code (NEC - NFPA 70) (USA)
• Canadian Electrical Code (CEC) (Canada)

SITRANS FST020 IP65 (NEMA 4X)
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For CE marked equipment the device complies with the following directives:
• Low voltage directive LVD 2014/35/EU
• EMC directive 2014/35/EU
• Restriction of hazardous substances directive 2011/65/EC and 2015/863/EU

3.2.1 Conformity with European directives
The CE marking on the device symbolizes the conformity with the following European directives:

Electromagnetic compatibil‐
ity EMC 
2014/30/EU

Directive of the European Parliament and of the Council on the 
harmonisation of the laws of the Member States relating to elec‐
tromagnetic compatibility

Low voltage directive LVD 
2014/35/EU

Directive of the European Parliament and of the Council on the 
harmonisation of the laws of the Member States relating to the 
making available on the market of electrical equipment designed 
for use within certain voltage limits

Restrictions on Hazardous 
Substances
RoHS 2011/65/EC and 
2015/863/EU

EU Directive: Restriction of Hazardous Substances in Electrical 
and Electronic Equipment Directive and Annex II Commission 
Delegated Directive 

The applicable directives can be found in the EU declaration of conformity of the specific 
device.

Note
CE declaration
The CE declaration certificate is available on the SensorFlash SD card delivered with the device. 

3.3 Requirements for special applications
Due to the large number of possible applications, each detail of the described device versions for 
each possible scenario during commissioning, operation, maintenance or operation in systems 
cannot be considered in the instructions. If you need additional information not covered by 
these instructions, contact your local Siemens office or company representative. 

Note
Operation under special ambient conditions
We highly recommend that you contact your Siemens representative or our application 
department before you operate the device under special ambient conditions as can be 
encountered in nuclear power plants or when the device is used for research and development 
purposes.

Safety notes
3.3 Requirements for special applications
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3.4 Lithium batteries
Lithium batteries are primary power sources with high energy content designed to represent the 
highest possible degree of safety.  

WARNING
Lithium batteries
Explosion Hazard - Can cause death or serious injury.
Lithium batteries may present an Explosion Hazard if they are abused electrically or 
mechanically. This is in most circumstances associated with the generation of excessive heat 
where internal pressure may cause the cell to rupture. 
Thus the following basic precautions should be observed when handling and using lithium 
batteries:
• Do not short-circuit, recharge or connect with false polarity.
• Do not expose to temperature beyond the specified temperature range or incinerate the 

battery.
• Do not crush, puncture or open cells or disassemble battery packs.
• Do not weld or solder to the battery’s body.
• Do not expose contents to water.

Safety notes
3.4 Lithium batteries
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Description 4
4.1 Overview

SITRANS FST020 Ultrasonic flowmeter systems consist of a transmitter and a sensor. The 
following table lists the available combinations of transmitters and sensors.

Transmitter Sensor type
FST020
 

FSS200
Clamp-on sensors for retrofitting on pipes
DN 15 to DN 9000 (0.5" to 360")
See FSS200 clamp-on sensors Installation Manual (https://
support.industry.siemens.com/cs/ww/en/view/109803765)
FSS100
Inline sensor for retrofitting on pipes
DN 100 to DN 4000 (4" to 160")
See FSS100 sensors Installation Manual (https://
support.industry.siemens.com/cs/ww/en/view/109955728)

4.2 Design
The transmitter reads the measured process values from the sensor and calculates derived 
values. It provides Modbus communications, 1x 4-20ma, 1x relay, and 1x Pulse/Frequency, USB 
service port, and a local display. It also adds functionalities such as totalizers, access control, 
diagnostics, and configuration. The local user interface consists of a display and four buttons for 
user interaction.
The transmitter has a modular design with discrete, replaceable electronic modules and 
connection boards to maintain separation between functions and facilitate field service. All 
modules are fully traceable and their provenance is included in the transmitter setup.
The SITRANS FST020 is available as:

SITRANS FST020 IP65 (NEMA 4X)
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Wall mount housings: AC and DC

Figure 4-1 DC Wall Mount housing shown

Description
4.2 Design
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4.3 FS120 system overview (internal DSL)
The illustration below shows a typical FST020 transmitter and FSS100 sensor flowmeter 
configuration. You can also connect the transmitter to other ultrasonic flow sensors.

① FST020 wall mount enclosure transmitter ⑤ Sensors
② Path 1 - upstream sensor cable (1A) ⑥ Flow direction
③ Path 1 - downstream sensor cable (1B) ⑦ Sensor ports
④ Power cable ⑧ Input power
    ⑨ Ports for I/O, Communications

Figure 4-2 Wall mount enclosure transmitter overview with FSS100 - FS120

Description
4.3 FS120 system overview (internal DSL)
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4.4 FS220 system overview (internal DSL)

FST020 system
The illustration below shows a typical FST020 transmitter and FSS200 sensor flowmeter 
configuration. You can also connect the transmitter to other ultrasonic flow sensors.

① FST020 wall mounted transmitter ⑤ Flow direction
② Power cable ⑥ Sensors
③ Path 1 - upstream sensor cable (1A) ⑦ Sensor ports
④ Path 1 - downstream sensor cable (1B) ⑧ Input power
    ⑨ I/O port

Figure 4-3 Wall mount transmitter overview (Reflect mount)

Description
4.4 FS220 system overview (internal DSL)
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4.5 Features
• Wall mount IP65 enclosure
• Full graphical local display
• SensorFlash (SD card) for memory backup, Datalogger and documentation storage 

(certificates etc.)
• USB service interface
• Modbus communications
• One pulse/frequency output
• One relay
• One current output 4-20 mA
• High immunity against process noise
• Fast response to step changes in flow
• High update rate (100 Hz) on all process values
• Measurement of:

– Volume flow
– Mass flow (with fixed density setpoint)
– Flow velocity
– Sound velocity

• Configurable upper and lower alarms and warning limits for nearly all process values
• Independent low flow cut-off settings for volume flow and mass flow
• Zero-point adjustment (initiated by host system)
• Process noise damping using digital signal processing (DSP)
• Simulation of process values
• Simulation of all outputs
• Simulation of alarms
• Enabling alarms for visibility on all outputs (HMI, status and communication)
• Comprehensive diagnostics (Siemens standard) for troubleshooting and sensor checking
• Firmware update
• Data logging in SensorFlash
• Peak indicators
• Alarm delay

Description
4.5 Features
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4.6 Applications
• Water industry
• Wastewater industry
• Chemical feed industry
• HVAC industry
• Power industry
• Process industry

Description
4.6 Applications
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Installing/mounting 5
5.1 Basic safety notes

Note
Pollution degree 2
Pollution degree 2 can be achieved by controlling the micro environment within the equipment 
by maintaining IP65.

CAUTION
Heavy object
Risk of personal injury if dropped. Installation may only be carried out by qualified personnel 
wearing proper personal protective equipment.

5.2 Chapter overview (transmitter)
This chapter describes how to install the wall mount housing transmitter.

Wall mount housing
The wall mount housing transmitter can be mounted either on a wall or on a pipe (with 
optional pipe mount bracket), see Installation instructions (Page 27).

5.3 Installation location requirements

5.3.1 Environment
SITRANS F flowmeters with minimum IP65/NEMA 4X enclosure rating are suitable for indoor 
and outdoor installations.

Process pressure and medium temperature
If applicable, make sure that specifications for rated medium temperature (TS) plus ambient 
temperature that are indicated on the device nameplate / label will not be exceeded.  

Aggressive atmospheres
Ensure that the device is suitable for the application and that it is installed where there is no 
risk of penetration of aggressive vapors.

SITRANS FST020 IP65 (NEMA 4X)
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Direct sunlight
Prevent the device from overheating or materials becoming brittle due to UV exposure 
by protecting it from direct sunlight. Make sure that the maximum permissible ambient 
temperature is not exceeded. Refer to the information in Technical specifications (Page 97).

WARNING
Electrical shock hazard
May cause death or serious injury
Disconnect power before working on this product.

Upstream / Downstream

WARNING
Fire Hazard
All user supplied cables connected to the transmitter must be suitable for 5°C above 
surrounding ambient temperature.

NOTICE
Strong vibrations
Damage to device.
• In plants with strong vibrations, mount the transmitter in a low vibration environment.

Avoid long drop lines downstream from the sensor to prevent the meter pipe from draining. 
Avoid installing the sensor upstream of a free discharge in a drop line where possible.

Sensor Location in piping system
The optimum location in the system depends on the presence of excessive gas or air bubbles 
in the fluid may result in erroneous measurements. Therefore, it is preferred not to install the 
sensor at the highest point in the system, where gas / air bubbles will be trapped. For liquids 
it is advantageous to install the sensor in low pipeline sections, at the bottom of a U-section 
in the pipeline.

5.3.2 Normal environmental conditions
Normal environmental conditions
This standard applies to equipment designed to be safe at least under the following 
conditions:
• Indoor and outdoor use
• Altitude up to 2000 m 
• Operating temperature -10 °C to 50 °C (14 °F to 122 °F)

Installing/mounting
5.3 Installation location requirements
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• Maximum relative humidity 80 % for temperatures up to 31 °C decreasing linearly to 50 % 
relative humidity at 40 °C (104 °F) 

• Mains supply voltage fluctuations up to ±10 % of the nominal voltage
• Transient Overvoltages up to the levels of Overvoltage Category II
• Temporary Overvoltages occurring on the Mains supply.
• Pollution Degree II

5.4 Installation instructions

5.4.1 Wall mount transmitter

Wall mounting

WARNING
Hazardous voltage
May cause death or serious injury
Disconnect power before working on this device.

The transmitter can be mounted on any wall surface including wood, metal or concrete. Use 
the appropriate bolts and screws as needed for your mounting application and adhere to 
local codes.
Prepare holes for the four screws (M6x100 or equivalent). Screw head diameter: max. 13.5 
mm; screw shaft diameter: max. 6 mm.
• Recommended mounting: Directly to wall or to electrical cabinet back panel.
• If alternate mounting surface is used it MUST support four times the weight of the unit.

Mounting the enclosure
1. Loosen the enclosure cover screws and open the cover to reveal the mounting holes.
2. Mark and drill four holes in the mounting surface for four mounting screws (supplied).
3. Using a long flat-blade screw driver, mount transmitter and tighten screws.

Installing/mounting
5.4 Installation instructions
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4. Tighten nuts (torque: 10 Nm).
5. Refer to Connecting the power supply (Page 33) and Sensor connections  (Page 33)  to 

complete installation.

Figure 5-1 Wall mounted transmitter showing mounting hole pattern

Installing/mounting
5.4 Installation instructions
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Connecting 6
This chapter describes how to wire up the transmitter. How to wire up the sensor is described in 
the sensor installation manual.
FSS200 sensors and FSS100 sensors are supplied with different types of cables. The 
configured Cable velocity factor can be found in display menu 2.1.5.14. Values can be found 
in table below. 

Sensor Cable velocity factor
FSS100 0.79
FSS200 0.84

To connect the transmitter use the following steps:
1. Transmitter power supply, communications and I/O connections (Page 33)  
2. Sensor connections (Page 33)
3. Connecting the power supply (Page 33) 
4. Connecting Inputs/Outputs (Page 35)
5. Connecting channel 1 (Page 36) (Modbus communication channel)

6.1 Basic safety notes

6.1.1 Missing PE/ground connection

WARNING
Missing PE/ground connection
Risk of electric shock. May cause death or serious injury.
Depending on the device version, connect the power supply as follows:
• Power plug: Ensure that the used socket has a PE/ground conductor connection. Check that 

the PE/ground conductor connection of the socket and power plug match each other.
• Connecting terminals: Connect the terminals according to the terminal connection 

diagram. First connect the PE/ground conductor.
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6.1.2 Energized devices

WARNING
Energized devices
Risk of electric shock. May cause death or serious injury.
When energized the device may be opened by qualified personnel only.

WARNING
Mains supply from building installation overvoltage category 2
A circuit breaker (max. 15 A) must be installed in close proximity to the equipment and within 
easy reach of the operator. It must be marked as the disconnecting device for the equipment.

WARNING
DC connection devices
The DC power source must be isolated from mains supply.

NOTICE
Condensation in the device
Damage to device through formation of condensation if the temperature difference between 
transportation or storage and the mounting location exceeds 20 °C (36 °F).
• Before taking the device into operation, let the device adapt for several hours in the new 

environment.

NOTICE
Ambient temperature too high
Damage to cable sheath.
• At an ambient temperature ≥ 60 °C (140 °F), use heat-resistant cables suitable for an 

ambient temperature at least 20 °C (36 °F) higher.

6.2 Disconnecting device

Overvoltage Category II
Connect mains supply through a circuit breaker (max. 15 A) in close proximity to the transmitter 
and within easy reach of the operator. Mark it as the disconnecting device for the transmitter.

Connecting
6.2 Disconnecting device
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6.3 Device nameplates
Each part of the system has one nameplate type showing the following information:
• product identification
• product specifications
• certificates and approvals

Note
Identification
Identify your device by comparing your ordering data with the information on the product 
and specification nameplates.

The transmitter is identified as 'Ultrasonic Transmitter SITRANS FST020'. The sensor is 
identified as 'Ultrasonic Sensor SITRANS FSS200' for clamp-on, or 'Ultrasonic Sensor SITRANS 
FSS100' for retrofit.

Connecting
6.3 Device nameplates
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Transmitter nameplates

7

2

1

3

6

5

4

8

9

10

11

12

3

6

13

14

15

16

① Product name Transmitter product name
② System order no. Device-specific system order number (transmitter and sensor)
③ Transmitter order 

no.
Transmitter replacement order numbers

④ Serial no. Transmitter serial number
⑤ System revisions System revision numbers; firmware (FW) and hardware (HW)
⑥ Power Supply Power supplies: AC and DC
⑦ Enclosure IP Degree of protection
⑧ Operating temper‐

ature
Operating temperature of the device

⑨ Agency marking Specific agency identification marking
⑩ ID link Product-specific ID link
⑪ Contact informa‐

tion address
Contact address for device information

⑫ Place of manufac‐
ture

Device place of manufacture

⑬ Year of Manufac‐
ture

Manufacturing year. More detailed manufacturing date information is 
given in the serial number (see sensor identification nameplate above)

⑭ WEEE symbol, see Disposal (Page 79)
⑮ Caution symbol
⑯ CE CE mark

Figure 6-1 Transmitter Labels: AC-DC

Connecting
6.3 Device nameplates
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6.4 Transmitter power supply, communications and I/O connections

6.4.1 Sensor connections
For sensor connection, see the FSS200 Sensor installation instructions manual.

6.4.2 Connecting the power supply

Note
If the transmitter is not already mounted and cabling has not been run, proceed to Mounting the 
Transmitter (Page 27) before connecting power.

WARNING
Hazardous Voltage
May cause death or serious personal injury.
Disconnect power before working on this product.

1. Using a flat-head screwdriver, loosen the six securing screws from the Keypad Enclosure 
Cover and open cover.

2. To determine type of power connection refer to the following part numbers:
– 7ME3570-1HA4 = AC Power (with 500mA fuse)
– 7ME3570-1HB4 = DC Power (with 2A fuse)

3. Remove input power blind plug and fit cable gland.
4. Push cable through open gland and cable path.
5. Loosen power plug connector screws.
6. Referring to the illustration and table below, as per local electric codes, wire input power 

connector for AC or DC power depending on power supply provided.

Connector pins AC DC
1 L1 +
2 L2/N -
3 Ground (PE) Ground (PE) 

Connecting
6.4 Transmitter power supply, communications and I/O connections
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7. Insert AC or DC power wires into wire entry holes and secure by tightening wire clamp screws 
using a screwdriver.
– For AC - Connect ground (PE) to terminal  and power to terminals L1 and L2/N.
– For DC - Connect ground (PE) to terminal  and power to terminals + and -.

Note
Power supply connector wires should be stripped stranded or solid conductors AWG 12-18.

11.5-28VDC

① Power input (AC or DC - see inserts) ⑥ Relay
② I/O terminals TB1 ⑦ 4-20 mA
③ Modbus ⑧ I/O input cable - 30m (98ft) max length
④ Totalizer ⑨ Power input cable
⑤ Pulse ⑩ Sensor cables - 90m (300 ft) max length

Figure 6-2 Input Power Wiring
8. Plug power connector into jack.

Connecting
6.4 Transmitter power supply, communications and I/O connections
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9. Tighten cable gland.
10.Connect the power cable to the appropriate power source (100-240 VAC @ 50/60 Hz or 

11.5-28.5 VDC) and power up unit.
WARNING

Circuit limited to 15 Amps
The branch circuit must be limited to 15A or damage to the unit and death or serious injury 
may result.
It is recommended that the circuit breaker be located near the transmitter.

6.4.3 Connecting Inputs/Outputs
1. Remove blind plugs where required from the flowmeter case.
2. Loosen spring screws on housing lid.
3. Open housing lid.

A label showing the device configuration is placed on the PC board inside the transmitter 
housing. It is either for AC or DC power depending on the flowmeter type.

Figure 6-3 Inside cover - AC and DC labels

Connecting
6.4 Transmitter power supply, communications and I/O connections
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6.4.4 Connection Wiring
Terminal Block Wiring
These connection diagrams apply to the part numbers listed below.

SITRANS FST020
FST020 7ME3570..._...

Figure 6-4 Terminal board channels and pin numbers

Note
4 to 20 mA current output Channel 2
It is not required to use shielded cables for the pure 4 to 20 mA current output.

Table 6-1 Input/Output Wiring
Pin# Signal Function Description

1 Io1+ Isolated Loop Supply Spannable 4-20mA output (Loop Powered) This 
output also provides a fault indication by drop‐
ping to 2mA if assigned to flow rate and under 
fault conditions.

2 Io1- Isolated Loop Return

3 Chassis Ground Ground
4 C Common Relay Output
5 NO Normally Open Relay Output
6 NC Normally Closed Relay Output
7 Chassis Ground Ground
8 PULSE OUTPUT + Transistor Menu selection: PGEN, POS TOTAL, NEG TOTAL
9 PULSE OUTPUT - Transistor
10 Chassis Ground Ground
11 NO TOT + DIGITAL INPUT + Freezes Totalizer to stop incrementing. 
12 NO TOT - DIGITAL INPUT -
13 CLR TOT + DIGITAL INPUT + Clears Totalizer 
14 CLR TOT - DIGITAL INPUT -
15 Modbus_B Differential + Serial communication, Modbus protocol
16 Modbus _A Differential - Serial communication, Modbus protocol
17 Chassis Ground Ground

Connecting
6.4 Transmitter power supply, communications and I/O connections
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Wiring

① 4 - 20mA output (current source) ④ Digital input (Freeze TOT)
② Relay output ⑤ Digital input (CLR TOT)
③ Pulse output ⑥ Modbus

Figure 6-5 Typical FST020 Wiring

Connect pulse output to galvanically isolated input

Figure 6-6 Alternative pulse output connection with galvanically isolated input

Connecting
6.4 Transmitter power supply, communications and I/O connections
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If the input is galvanically isolated the polarity does not need to be inverted.

Isolated 4-20mA Output TB1-1/2
R = 250 Ω typical, 750 Ω maximum
Vc = 24 VDC typical / 30 VDC maximum
I = 4-20mA
RL = Loop wire resistance (both ways) plus User's input load resistance.

Pulse output TB1-8 / TB1-9
Vc = +30 VDC max.
RL = 3K Ω minimum

Digital Inputs TB1-11 / TB1-12 and TB1-13 / TB1-14
Vc = (10V + 0.02 x RL) max. 2 ≤ Vc ≤ 30 VDC
0 ≤ RL ≤ 1000 Ω  

Activate or deactivate digital input on channel 7 (freeze totalizer) or channel 8 (clear totalizer)
1. Apply voltage VC according to your wiring to activate function on channel 7 or channel 8.
2. Apply short circuit between pins to deactivate function.

See also
Connecting Inputs/Outputs (Page 35)

6.4.5 Finishing the transmitter connection (wall mount housing)

Connection check-up
1. Check individual wire installation by tugging firmly.
2. To ensure IP rating, remove caps and mount appropriate cable glands and blind plugs in 

unused cable entries.
Firmly tighten cable glands.

3. Check individual wire installation by tugging firmly. 
4. Close lid.
5. Tighten the six spring screws.
6. Ensure that moisture does not penetrate to inside of electronics enclosure.

Connecting
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Commissioning 7
7.1 Basic Safety notes

7.1.1 Hazardous contact voltage

WARNING
Hazardous contact voltage
May cause death or serious injury.
Risk of injury through hazardous contact voltage when the device is open or not completely 
closed. 
The degree of protection specified on the nameplate or in Technical data  (Page 97)is no 
longer guaranteed if the device is open or not properly closed.
• Make sure that the device is securely closed.

WARNING
Commissioning and operation with error message
If an error message displays, correct operation is no longer guaranteed.
• Check the severity of the error.
• Correct the error.
• If the error still exists:

– Take the device out of operation.
– Do not restart the device.

The same risk continues to apply when error messages are switched off or disabled.

WARNING
Hot surfaces
Risk of burns resulting from hot surfaces.
• Take corresponding protective measures, for example by wearing protective gloves.
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7.2 General requirements
Before commissioning it must be checked that:
• The device has been installed and connected in accordance with the guidelines provided 

in Installing/mounting (Page 25) and Connecting (Page 29).
This chapter gives instructions to commissioning your device, see Local display (Page 40).
Furthermore, the device can be commissioned using SIMATIC PDM, see Commissioning with 
SIMATIC PDM (Page 121).

7.3 Local display
The device is commissioned/operated with the touch keypad on the local display. 
The graphic display above the keypad gives a menu-guided operation of the individual device 
function/parameters. Successful operation of the key is confirmed by tactile feedback as key 
is pressed.

① Full graphical display
② Touch keypad

Figure 7-1 Local display

Note
Local display timeout
If no key is pressed for 10 minutes, the display switches to show operation view. If Backlight is 
set to Automatic, display backlight goes off automatically 30 seconds after the last key press.

Note
Operation does not require opening of the device. This means that the IP65 degree of protection 
is guaranteed at all times.

Commissioning
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7.4 Access control
You can view all items in the HMI menu but the parameters are protected against changes 
through access level control. To gain access, select one of the following access levels:

Figure 7-2 SelectAccessLevel
• Read only

Allows no configuration. The parameter values can be viewed only (indicated by a  symbol). 
No PIN code required.

• User
Allows configuration and service of all parameters except calibration parameters. Default PIN 
code is 2457.

• Expert
Allows configuration and service of all parameters including flow and calibration parameters. 
Default PIN code is 2834.

PIN codes can be changed in "Security" (menu item 5).

Note
Lost PIN code
If the PIN code is lost, provide Siemens customer support with the "Recovery ID" (menu item 5.3). 
Siemens customer support will provide a personal unblocking key (PUK) to be entered in "PIN 
recovery" (menu item 5.4).

Disable access level control
If logged in as Expert you can Deactivate user PIN. As User you will not be prompted to enter 
the password. With deactivated user PIN the default access level remains as "User" making expert 
level parameters unavailable. Enabling the access level control can be done in Activate user PIN 
and requires entering the Expert password.

Auto logout function
You will not be prompted for password for 10 minutes after the last button press.

NOTICE
Device restart
Whenever the device is restarted, the access level is reset to "Read only".

Commissioning
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7.5 Device startup

Condition
You have read the Basic Safety notes (Page 39).

Procedure
1. Power-on the device.

For an initial startup, prompts for each of the following steps appear after power-on.
2. Set the language. 

The first time the device is configured, you will be prompted to set the language. The 
parameter "Language" always appears in English. To change the language after initial setup, 
access menu item 6.

3. Set the date and time.
The correct date and time should be set prior to configuring the device.

4. Run the "Quick commissioning wizard".
Essential parameters should be considered before using the device for the first time.
– Choose "Yes" (recommended) to start the "Quick commissioning" wizard. 
– Choose "No", you accept the default values of the device (no sensors are configured). 

The next HMI view will be the operation view 1.
For any subsequent startup, after power-on, the device automatically starts in operation 
view. A transition screen showing first the Siemens logo and then the current firmware 
revision of the product is displayed while the first measurement is being processed. 

See also
FST020 HMI export in SIOS (https://support.industry.siemens.com/cs/ww/en/view/
109954689)

7.6 Wizards
The first view in each wizard (About - view 1) is a description of what settings/actions can be 
performed using the specific wizard.
The last view in each wizard (Finished) shows that the last step of the wizard was completed.
Any parameter changes confirmed with  are saved immediately. 
At any time in any wizard selecting Exit will bring you back to the main wizard menu without 
discarding changes.

Commissioning
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① Wizard name
② Step name / Parameter name
③ View number / Total views in wizard

The purpose of the wizards is to guide you through a quick set-up of various parameters.
The following HMI wizards are available:
• Quick commissioning
• Sensor settings
Use the  and  buttons to highlight the desired wizard and press right key to enter the 
wizard. The first view shows a short description of which settings can be done.

Table 7-1 Button functions - wizards
Button Function

Leave menu without saving changes
Scroll up in list of options/change parameter value
Scroll down in list of options/change parameter value
First button press: Select option.
Second button press: Confirm selection and save setting.
When you reach the end of the wizard, e.g. "The Process values wizard is now finished.": 
return to wizard list

Commissioning
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7.7 Commissioning FSS100

Condition
• You have installed and connected the FST020 transmitter and FSS100 sensor

Note
FSS100 sensors can be installed only as a single path sensor setup.
For more detailed information on FSS100 sensors and installation instructions for FSS100 
sensor, see SITRANS FSS100 Installation Manual.

• You know the following parameters for your installation:
– Pipe circumference C  or Outer pipe diameter Do
– Pipe wall thickness t
– Beam angle θ
– Path length L
– Expected sound velocity
– Kinematic viscosity

1A 

1A 1B

1B

Figure 7-3 FSS100  - 1 path

Procedure

Note
Disable Flow Profile Compensation
Flow Profile Compensation is intended for usage with FSS200 clamp-on sensors only and must 
remain disabled when the FST020 is used in combination with FSS100 sensors. The functionality 
is per default disabled in FST020 transmitters when sold for FSS100 sensors.

Commissioning
7.7 Commissioning FSS100
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To commission FSS100 sensor use Quick commissioning wizard. How to navigate the wizard 
is described in Wizards chapter.

Commissioning
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Operating 8
8.1 Operating the device on the local display

8.1.1 Display views
There are three view types:
• Operation view

The operation views are fully configurable to show different process values in different 
operation view types. Depending on the operation view type configuration the view is one 
of the following:
– Reading the process values (Page 50): Show the measurement values.
– Handling alarms and diagnostics (Page 53): Show the active alarms in a list.
– Operating the totalizers (Page 52): Enable the totalizer reset and the dosing control.

• Parameter view
The Parameter view (Page 55) shows the menus and parameters. The parameter view is 
used to navigate through the menus and parameters in the device.

• Edit view
The Edit view can be entered from the parameter view. The edit view is used to edit the 
parameters.

SITRANS FST020 IP65 (NEMA 4X)
Operating Instructions, 06/2024, A5E41425845-AD 47



Navigating in the views
The following graphic shows an example of how to navigate between operation views and alarm 
views.

① Operation view
② Access level view
③ Operation view
④ Operation view
⑤ Alarm view - level 1
⑥ Alarm view - level 2
⑦ Alarm view - level 3

See also
Reading the view type 6 values (Page 54)

Operating
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You can navigate through the menu structure items in the device using the four buttons on the 
display as described below.

Table 8-1 Key functions - menu structure navigation
Key Function

Return to previous item.
Select the item above.
Select the item below.
Enter the selected item.

8.1.2 Fixed display texts
Some displayed texts are fixed, which means they will not change regardless of changed display 
language.
The following tables list the fixed display texts and their corresponding process value, 
diagnostic value, and compensation value names.

Table 8-2 Process values
Fixed display text Process value name
VOL FLOW Volume flow
MASS FLOW Mass flow
FLOW VEL Flow velocity
SOUND VEL Sound velocity
DENSITY Density
KIN VISCOSITY Kinematic viscosity
PRESSURE Pressure
MEDIUM TEMP Medium temperature
TOT1 Totalizer 1 
AUX TEMP Auxiliary temperature

Table 8-3 Diagnostic values
Fixed display text Diagnostic value name (#=channel number)
TRN TEMP Transmitter internal temperature
SEN TEMP 1 RTD temperature 1
SEN TEMP 2 RTD temperature 2
CURR OUT CH# Current output value
CURR IN CH# Current input value
PULSE OUT CH# Pulse output amount
FREQ OUT CH# Frequency output
DIG IN CH# Digital input value
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Fixed display text Diagnostic value name (#=channel number)
STAT OUT CH# Status output value
DSL TEMP Sensor internal temperature
REYNOLDS NO Reynolds number
P# SNR UP SNR up path #
P# SNR DOWN SNR down path #
P# SOUND VEL Sound velocity path #
P# DELTA TIME Delta time path #
P# ACC BURST Percentage of bursts accepted path #
P# PEAK AMP DN Peak amplitude down path #
P# PEAK AMP UP Peak amplitude up path #
P# TTIME MAX Maximum acceptable travel time for path #
P# TTIME MIN Minimum acceptable travel time for path #
P# CORR FACT Signal correlation factor path #
P# FLOWVEL Flow velocity path #
P# RXGAIN UP Upstream signal amplifier gain path #
P# RXGAIN DN Downstream signal amplifier gain path #

8.1.3 Reading the process values
The current value of the process values can be displayed either as one or more numeric values 
or as numeric value(s) in combination with a graph/bargraph. The following view types are 
available:
• 1 value
• 1 value and horizontal bar graph
• 1 value and trend chart
• 3 values and horizontal bar graph
• 6 values
• Totalizer
• Diagnostics

Table 8-4 Key functions - measurement view
Key Function

No functionality
Go to the previous measurement view
Go to the next measurement view
Enter the parameter view

1 value
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1 value and horizontal bar graph

Note
Bar graphs
The bar graph limit values indicate the set lower and upper alarm limits, and the vertical lines in 
the bar graph indicate the set lower and upper warning limits. 

1 value and trend chart

3 values and horizontal bar graph
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6 values

8.1.4 Operating the totalizers
When totalizer is displayed in the main view, press  to access the totalizer operation.

Table 8-5 Key functions - totalizer operation
Key Function

Exit totalizer operation
Select action to perform
Select action to perform
Perform selected action

The available actions are:
• Reset and resume
• Reset and hold
• Preset and resume
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• Preset and hold
• Resume
• Hold

8.1.5 Handling alarms and diagnostics
When the alarm list is displayed in the main view, press  to get more detailed information 
about the active alarms.

Table 8-6 Key functions - alarms list view
Key Function

Exit alarm list view
Select the item above in the list; keep pressing the key to accelerate scrolling up the selec‐
tion list
Select the item below in the list; keep pressing the key to accelerate scrolling down the 
selection list
View more information on the selected alarm
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Press  to exit the detailed alarm information.

Alarm acknowledgement
There are two ways to have the alarms removed from the alarm list.
• Manual: The alarm remains in the alarm list until the alarm is manually acknowledged (ack.). 

Before the alarm can be acknowledged, the cause must be eliminated. Press  to go to the 
detailed alarm information. Press  again to acknowledge the alarm. The time of the 
acknowledgement is shown in the history log.

• Auto: The alarm is removed from the alarm list when the cause is removed (going)

8.1.6 Reading the view type 6 values
One of the main views can be configured to show six diagnostic values.

Operating
8.1 Operating the device on the local display

SITRANS FST020 IP65 (NEMA 4X)
54 Operating Instructions, 06/2024, A5E41425845-AD



8.2 Reading / changing parameters

8.2.1 Parameter view
The exact structure of the operating menu is explained in the FST020 menu structure (https://
support.industry.siemens.com/cs/ww/en/view/109954689).
All items of the menu structure of the device are identified with a unique number.
Level 1 of the menu structure is standardized for all Siemens Process Instrumentation devices 
and covers the following groups:
1. Quick start: Lists the most important parameters for quick configuration of the device. All 

parameters in this view can be found elsewhere in the menu.
2. Setup: Contains all parameters which are needed to configure the device.
3. Maintenance and diagnostics: Contains parameters which affect the product behavior 

regarding maintenance, diagnostics and service.
4. Communication: Contains parameters which describe the communication settings of the 

device.
5. Security: Contains parameters which describe all security settings of the device.
6. Language (Language): Parameter for changing the language of the local display. Regardless 

of the language setting, the term in paranthesis for this parameter is always the English term 
(Language).

1

2 3

45

① List of menu structure items
② Name of the previously selected item
③ Number of highlighted item
④ Alarm status text
⑤ Device status icon

Figure 8-1 Level 1 of the menu structure
Depending on your access level, you can read the current value or edit the value of the selected 
parameter.   
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8.2.2 Alphanumeric parameters

Read only
The view shows the set value. Press  to exit the view.

Edit
Editable alphanumeric parameters are displayed as shown here. 

Table 8-7 Key functions - editing alphanumeric values
Key Function

Select the next left position.
If the most left position is selected: exit the parameter edit view without confirming the 
changes. Keep pressing the key to jump to the most left position.
Change the selected number/character.
Numeric characters: increase the number by one (for example from 7 to 8)
ASCII characters: select the previous character in the alphabet.
Change the selected number/character.
Numeric characters: decrease the number by one (for example. from 8 to 7)
ASCII characters: select the next character in the alphabet.
Select the next right position.
If most right position is selected: confirm the change and exit the parameter edit view. Keep 
pressing the key to jump to the most right position.

Note
Ensure that the new value is within the minimum/maximum range when changing numeric 
values.
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Note
##### signs in display
The display is unable to show the measured value or the value is missing or invalid. Try to fix by 
changing the measurement units or the resolution.

Changing the resolution
In order to change the number of visible decimals shown in the operation view, set the decimal 
places as defined in Decimal places (for example menu number 2.2.2.4).
The resolution can also be changed by changing the resolution of one configuration 
parameter for this process value (for example Low flow cut-off menu number 2.2.2.5). Any 
changes in resolution will change the resolution of all other configuration parameters for this 
process value as well.

8.2.3 Parameter lists
Parameter list - read only

Table 8-8 Key functions - read only
Key Function

Exit parameter list
No functionality
No functionality
No functionality
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Parameter list - editable
The help texts describe the possible adjustments of the respective parameters.

Table 8-9 Key functions - edit
Key Function

Escape the view without changing the value.
Select the option above.
Select the option below.
Confirm selected option.

Multiselection

Table 8-10 Key functions - multiselection of options
Key Function

Escape the view without changing the value.
Scroll up in the list.
If the uppermost position is selected: highlight Save settings.
Scroll down in the list.
If the lowermost position is selected: highlight Save settings.
Select / deselect option. 

It is possible to select/deselect multiple alarms to be suppressed. The marked alarms will NOT 
be suppressed.
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8.3 Alphanumeric parameters
Read only
The view shows the set value. Press  to exit the view.

Edit
Editable alphanumeric parameters are displayed as shown here. 

Table 8-11 Key functions - editing alphanumeric values
Key Function

Select the next left position.
If the most left position is selected: exit the parameter edit view without confirming the 
changes. Keep pressing the key to jump to the most left position.
Change the selected number/character.
Numeric characters: increase the number by one (for example from 7 to 8)
ASCII characters: select the previous character in the alphabet.
Change the selected number/character.
Numeric characters: decrease the number by one (for example. from 8 to 7)
ASCII characters: select the next character in the alphabet.
Select the next right position.
If most right position is selected: confirm the change and exit the parameter edit view. Keep 
pressing the key to jump to the most right position.

Note
Ensure that the new value is within the minimum/maximum range when changing numeric 
values.
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Note
##### signs in display
The display is unable to show the measured value or the value is missing or invalid. Try to fix by 
changing the measurement units or the resolution.

8.3.1 Changing the resolution

Changing the resolution
In order to change the resolution of the process value shown in the operation view (for example 
mass flow), set the decimal places parameter for the selected process value. For example, the 
decimal places for process value Mass flow is defined in Decimal places.
The resolution can also be changed by changing the resolution of one configuration 
parameter for this process value. For example Low flow cut-off. Any changes in resolution 
will change the resolution of all configuration parameters for this process value as well.

Parameter list - read only

Table 8-12 Key functions - read only
Key Function

Exit parameter list
No functionality
No functionality
No functionality
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Parameter list - editable
The help texts describe the possible adjustments of the respective parameters.

Table 8-13 Key functions - edit
Key Function

Escape the view without changing the value.
Select the option above.
Select the option below.
Confirm selected option.

Multiselection

Table 8-14 Key functions - multiselection of options
Key Function

Escape the view without changing the value.
Scroll up in the list.
If the uppermost position is selected: highlight Save settings.
Scroll down in the list.
If the lowermost position is selected: highlight Save settings.
Select / deselect option. 

It is possible to select/deselect multiple alarms to be suppressed. The marked alarms will NOT 
be suppressed.
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Parameter assignment 9
9.1 Multipoint calibration

The transmitter provides an additional 20 point piecewise linear calibration table with user 
selectable input value: volume flow, reynolds number or fluid sound velocity. The table can be 
configured for either unidirectional or bidirectional calibration.

Note
Ascending order by reynolds number
The datapoints must be entered in ascending order by reynolds number.

SITRANS FST020 IP65 (NEMA 4X)
Operating Instructions, 06/2024, A5E41425845-AD 63



Point Reynolds number Calibration correction Point Reynolds number Calibration correction
① 47339 1.0050 ⑪ 54231 0.9930
② 94701 1.0060 ⑫ 102932 0.9934
③ 156034 1.0058 ⑬ 141382 0.9942
④ 238385 1.0062 ⑭ 271843 0.9975
⑤ 402304 1.0017 ⑮ 402304 0.9984
⑥ 532765 0.9971 ⑯ 532765 0.9971
⑦ 663226 0.9960 ⑰ 663226 1.0015
⑧ 793687 0.9950 ⑱ 0 0
⑨ 0 0 ⑲ 0 0
⑩ 0 0 ⑳ 0 0

Figure 9-1 User calibration table behavior (bidirectional calibration)
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Point Reynolds number Calibration correction
① 47339 1.0050
② 94701 1.0060
③ 156034 1.0058
④ 238385 1.0062
⑤ 402304 1.0017
⑥ 532765 0.9971
⑦ 663226 0.9960
⑧ 793687 0.9950
⑨ 0 0
⑩ 0 0

Figure 9-2 User calibration table behavior (unidirectional calibration)

9.2 Inputs and outputs
The available configuration of the hardware functionality of input and output is described in the 
following table.

Table 9-1 Hardware and software configuration of the input/output channels
Channel HW configuration

(fixed when ordering)
SW configuration
available to the user

1 Modbus Modbus
2 Current output Current output (0/4-20 mA)
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Channel HW configuration
(fixed when ordering)

SW configuration
available to the user

3 Relay output Status Output:
• Status signals
• Alarm and diagnostics
• Flow direction

4 Output • Frequency output
• Pulse output

7 Digital input Reset totalizer 1
8 Digital input Pause/resume totalizer 1

Current output
Current output configuration
The following process values can be assigned to the current output: 
• Volume flow
• Mass flow
• Flow velocity
• Sound velocity
• Density
• Kinematic viscosity
• Medium temperature
The accuracy specified for the analog output signal applies only within the range 4 to 20 mA. 
Lower limit (4 mA) and upper limit (20 mA) can be assigned to any specific measurement 
values.
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① Linear control range
② Lower saturation limit
③ Upper saturation limit
④ Lower fault current value
⑤ Recommended setting range for lower fault current
⑥ Recommended setting range for upper fault current
⑦ Measuring range

Figure 9-3 Current limits for NAMUR configuration
The fail safe current output signal can be selected to:
• Lower fault current (defined in the Loop current scale selection)
• Upper fault current (defined in the Loop current scale selection)
• Last valid value (the last process value before the failure occurred)
• Current value (actual measured value)
• Fail-safe value (within the range of 0 mA to 25 mA 1))

Output scaling configuration
Below are four examples describing configuration possibilities for a current output.
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Positive flow with negative scaling

vv

mA

kg /h

100 kg/h
400 kg/h

v v v

① Low flow cut-off
② Upper range value
③ Maximum output current
④ Upper fault current
⑤ Lower range value
⑥ Lower saturation limit
⑦ Span

Current output setting
• Process value = Mass flow
• Direction = Positive
• Loop current scale = 4-20 mA (maximum 25 mA)
• Upper range value = 100 kg/h
• Lower range value = 400 kg/h
• Fail-safe behaviour = Upper fault current
• Low flow cut-off = 25 kg/h
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Positive flow across zero with positive scaling

vv

mA

m3/h

-250 m3/h
1000 m3/h

v vv

① Lower range value
② Low flow cut-off
③ Upper range value
④ Upper saturation limit
⑤ Lower saturation limit
⑥ Lower fault current
⑦ Measuring range

Current output setting
• Process value = Mass flow
• Direction = Bidirectional
• Loop current scale  = 4-20 mA NAMUR
• Upper range value = 1000 m3/h
• Lower range value = -250 m3/h
• Fail-safe behaviour = Upper fault current
• Low flow cut-off = 25 m3/h
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Bidirectional flow across zero with positive scaling

vv

mA

Kg/h

v vv

① Lower range value
② Low flow cut-off
③ Upper range value
④ Upper saturation limit
⑤  Lower saturation limit 
⑥ Lower fault current
⑦ Span

Current output setting
• Process value = Mass flow
• Direction = Bidirectional
• Loop current scale = 4-20 mA US
• Upper range value = 400 kg/h
• Lower range value = -100 kg/h
• Fail-safe behaviour = Minimum current
• Low flow cut-off = 25 kg/h
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Bidirectional flow with symmetrical scaling

vv

mA

Kg/h

v v

v

vv

① Upper range value
② Lower range value
③ Low flow cut-off
④ Upper fault current
⑤ Upper saturation limit
⑥ Lower saturation limit
⑦ Span

Current output setting
• Process value = Mass flow
• Direction = Bidirectional (Symmetric)
• Loop current scale = 4-20 mA NAMUR
• Upper range value = 400 kg/h
• Lower range value = 100 kg/h
• Fail-safe behaviour = Upper fault current
• Low flow cut-off = 25 kg/h

Pulse output
The pulse output function supplies pulses equivalent to a configured amount of accumulated 
volume or mass. The pulse width is configured and the pulse repetition is proportional to the 
selected flow rate.

Pulse repetition
Pulse repetition is calculated as follows:
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Example
• Pulse output configuration (channels 2 to 4)

– Operation mode = Pulse output
– Process value = Mass flow
– Amount per pulse = 1 kg
– Pulse width = 1 ms

• Measured mass flow value = 10 kg/s (constant)
Result:
• Pulse repetition = 100 ms
• Output frequency = 10 pulses per second with a pulse width of 1 ms
• Remaining time between pulses is 99 ms

Note
Pulse width must be selected with the view that remaining time is always greater than pulse 
width at the highest measured flow.

Frequency output
The frequency output function supplies a frequency (50% duty cycle) proportional to the 
selected process value.
Frequency is calculated as follows:

Example
This example shows how to calculate the output frequency for any measured flowrate:
Frequency output configuration:
• Operation mode = Frequency output (Channel 2 to 4)
• Process value = Mass flow
• Direction = Positive
• Frequency value high = 12 kHz
• Frequency value low = 2 kHz
• Upper range value = 15 kg/s
• Lower range value = 5 kg/s
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Measured mass flow value = 7.5 kg/s (constant)
Result:
● Frequency = 4.5 kHz

Note
The connected equipment must be capable of registering the full range of frequencies 
configured.

Status output
The status output can be used to show alarm status and it can be signaled on Status output or 
Relay output.

Note
Flow direction warning
The limit function for the current output can be used to signal the flow direction by setting the 
Lower warning limit for the Process value to 0. A warning will occur in case of negative flow.
This warning can be output on the status ouput if Status mode is set to Alarm item and the 
Process alarms (1) [relevant process value] below warning limit is selected.

Depending on the Status mode setting, multiple alarms can be signaled on the output and 
selected from the alarm class or the alarm item lists.
• Alarm class: Alarm will be signaled if alarm within the selected alarm class occurs. 
• Alarm item:  Alarm will be signaled if selected alarm item occurs. It is possible to select 

multiple  alarms to be signaled.
Note
Alarm class / NAMUR status signals
The options depend on the setting selected in Staus icons, either NAMUR status signals or 
Alarm class (Siemens Standard).

9.2.1 Digital input

Digital input
If the input signal is activated with a logical signal (15 to 30 V DC) and the Polarity is set to Active 
high level, the meter carries out an activity selected in the menu Input function:
• Reset totalizer 1 on channel 7
• Pause/resume totalizer 1 on channel 8
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Note
Changing polarity
Changing the polarity triggers the signal input to executes the parameterized function.
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Service and maintenance 10
10.1 Basic safety notes

NOTICE
Penetration of moisture into the device
Damage to device.
• Make sure when carrying out cleaning and maintenance work that no moisture penetrates 

the inside of the device.

10.1.1 Impermissible repair of the device

WARNING
Impermissible repair of the device
• Repair must be carried out by Siemens authorized personnel only.

10.2 Cleaning

Cleaning the enclosure
• Clean the outside of the enclosure with the inscriptions and the display window using a cloth 

moistened with water or a mild detergent.
• Do not use any aggressive cleansing agents or solvents, e.g. acetone. Plastic parts or the 

painted surface could be damaged. The inscriptions could become unreadable.
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10.3 Maintenance and repair work

WARNING
Humid environment
Risk of electric shock.
• Avoid working on the device when it is energized.
• If working on an energized device is necessary, ensure that the environment is dry.
• Make sure when carrying out cleaning and maintenance work that no moisture penetrates 

the inside of the device.

CAUTION
Hazardous voltage at open device
Risk of electric shock when the enclosure is opened or enclosure parts are removed.
• Before you open the enclosure or remove enclosure parts, de-energize the device.
• If maintenance measures in an energized state are necessary, observe the particular 

precautionary measures. Have maintenance work carried out by qualified personnel.

The device is maintenance-free. However, a periodic inspection according to pertinent directives 
and regulations must be carried out.   
An inspection can include:
• Ambient conditions
• Seal integrity of the process connections, cable entries, and cover
• Reliability of power supply, lightning protection, and grounds

10.3.1 Service and maintenance information
Service and maintenance information is information about the condition of the device used for 
diagnostics and service purposes.   
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Maintenance information parameters
The basic maintenance information parameters are:
• Identification

– Order number
– Long tag
– Descriptor
– Location
– Installation date
– Product name
– Hardware and firmware versions 

• Condition and setup
– Peak values
– Signal monitoring
– Temperature monitoring
– Monitoring of inputs and outputs
– Operating time
– Parameter change log
– FW update log
– Diagnostic log

Service information parameters
• Operating time total
• Operating time
• Transmitter hardware version
• Display module hardware version

10.3.2 On-board battery replacement

Note
The on-board battery is used to maintain real time clock and should only be replaced with 
Panasonic BR1225A/BN. 
Siemens spare part number: A5E41372210
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10.3.3 Replacing SensorFlash card

Procedure
1. Use parameter 3.7.2.2 to enable the Mass storage device (MSD) function. This step ensures 

no further writing to the card from the device (e.g. data logging) is permitted.
If the MSD function is not available, disable data logging instead (3.7.5).

2. Isolate the device from power.
3. Open the device. Locate the SensorFlash card as described in AC Transmitter exploded view 

(Page 103).
4. Remove the SensorFlash card by pressing and releasing it.

Recommended: Insert card that was removed into a PC and make a backup of all files.
5. Insert the replacement SensorFlash card, close the device, and reconnect power to the 

device.
Value for parameter "Installed" (3.7.1), will display "Yes" when SensorFlash is installed 
properly.

Note
Diagnostic may result when replacing SensorFlash card
• If SensorFlash card is replaced with a blank card, no diagnostic is displayed.
• If SensorFlash card is replaced with a card from another device, diagnostic ID 151 displays. 

This diagnostic is a notice that configurations can be copied from one device to another 
without overwriting data. When the SensorFlash card is once again inserted into the original 
device, the data is unchanged, and the SensorFlash card works with the original device.

10.4 Return procedure
To return a product to Siemens, see Returns to Siemens (www.siemens.com/returns-to-
siemens).
Contact your Siemens representative to clarify if a product is repairable, and how to return 
it. They can also help with quick repair processing, a repair cost estimate, or a repair report/
cause of failure report.

NOTICE
Decontamination
The product may have to be decontaminated before it is returned. Your Siemens contact 
person will let you know for which products this is required.

See also
Decontamination declaration (https://www.siemens.com/sc/declarationofdecontamination)
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10.5 Disposal
  Devices described in this manual should be recycled. They may not be dis‐

posed of in the municipal waste disposal services according to the Directive 
2012/19/EC on waste electronic and electrical equipment (WEEE).
Devices can be returned to the supplier within the EC and UK, or to a locally 
approved disposal service for eco-friendly recycling. Observe the specific 
regulations valid in your country.
Further information about devices containing batteries can be found at: 
Information about battery / product return (WEEE) (https://
support.industry.siemens.com/cs/document/109479891/)
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Diagnostics and troubleshooting 11
11.1 Device status symbols

Device status is shown using symbols and text on the local display. Additionally, the symbol and 
respective text message for each device status can be seen in remote engineering, asset 
management or process control systems.
Messages are shown on the display. 
• In the operation view, alarms are shown as a combination of symbol and text in the lower line 

of the display. If several diagnostic messages are active at the same time, the most critical is 
shown.

• In the alarm list view all active alarms are shown as a list. The alarm list combines a symbol, 
text and an alarm ID number. The alarms are arranged according to the alarm ID numbers. 
The alarm list view can also be accessed via parameter "Active diagnostic events".

• In the alarm history view the most recent alarms (up to 100) are listed. The alarm history log 
can be viewed in parameter "Diagnostic log". The alarm history log can be reset in parameter 
"Reset log".

Device status characteristics
The following table provides possible cause of device status, and actions for the user or 
service.
The device provides two types of alarm formats; symbols used on the local display are based 
on NAMUR status signals or Siemens standard alarm classes, selected in parameter "Status 
icons". 
In SIMATIC PDM, symbols are based on Siemens standard alarm classes.

11.2 Device status symbols (chart)
The sequence of symbols in the table corresponds to the priority of the device status, beginning 
with the most critical.

Device status symbols
Local display 
- Siemens standard

SIMATIC PDM/PLC

Symbol Device status Priority ** Symbol Device status Priority **
Maintenance 
alarm

1

 

Maintenance 
alarm

1

Cause: Output signal invalid due to fault in the field device or in the peripherals.
Action: Maintenance is required immediately.
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Local display 
- Siemens standard

SIMATIC PDM/PLC

Symbol Device status Priority ** Symbol Device status Priority **
Maintenance 
demanded
 

2 Maintenance 
demanded
 

2

Cause: Output signal is still valid, but wear reserve is almost exhausted and/or a function will be limited soon.
Action: Maintenance is strongly recommended as soon as possible.
 

Maintenance re‐
quired

3 Maintenance re‐
quired

3

Cause: Output signal is still valid. No functional restriction detected but end of wear reserve expected in next weeks.
Action: Maintenance of device should be planned.
 

Manual opera‐
tion

4 Manual opera‐
tion

4

Cause: Output signal temporarily invalid (e.g. frozen) due to work being performed on the device.
Action: Disable manual mode via HMI or engineering system.
 

Simulation or 
substitute value

5 Simulation or 
substitute value

5

Cause: Output signal temporarily does not represent the process because output based on a simulation value.
Action: Disable simulation mode via HMI or engineering system or restart device.
 

Out of service 6 Out of service 6

Cause: Output signal does not represent process value. Device mode is set to "Out of service".
Action: Disable "Out of service" and enable normal operation.
 

Configuration 
error

7

(red)

Configuration 
error

7

Cause: Output signal invalid due to parameter setting, connection error or configuration error in the HW.
Action: Check hardware configuration or parameter settings of the device via HMI or engineering system.
 

Process value 
alarm

8 Process value 
alarm

8

Cause: Deviations from permissible ambient or process conditions detected by the device (through self-monitoring, or warn‐
ings / faults in the device) indicate that the measured value is unreliable or deviations from the set value in the actuators is most 
likely greater than anticipated under normal operating conditions. Process or ambient conditions will damage the device or 
result in unreliable output.
Action: Check ambient temperature or process conditions. If possible, install device at different location.
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Local display 
- Siemens standard

SIMATIC PDM/PLC

Symbol Device status Priority ** Symbol Device status Priority **
Configuration 
warning

9

(yellow)

Configuration 
warning

9

Cause: <<for SIL device>>Safety validation is not completed.
Action: <<for SIL device>>Complete the functional test and confirm that the functional test has passed in the wizard Func‐
tional Safety.
Cause: <<for non-SIL device>>Device can operate, but one or more parameters are incorrectly configured.
Action: <<NO action for non-SIL device>>
 

Process value 
warning

10

   

Process value 
warning

10

Cause: Deviations from permissible ambient or process conditions detected by the device (through self-monitoring, or warn‐
ings / faults in the device) indicate that the measured value is unreliable or deviations from the set value in the actuators is most 
likely greater than anticipated under normal operating conditions. Process or ambient conditions can damage the device or 
result in unreliable output.
Action: Check ambient temperature or process conditions. If possible, install device at different location.
 

Process value 
tolerance

11   Process value 
tolerance

11

Cause: At least one process value has exceeded or fallen below a process tolerance limit parameter set in device.
Action: Check that limit parameter settings are suitable for application. 
 
no symbol 
shown

Configuration 
changed

12   no symbol 
shown

Configuration 
changed

12

Cause: The device configuration has changed due to a work process.
Action: Reset configuration flag to clear diagnostic message.
 
no symbol 
shown

no assignment 13   no symbol 
shown

no assignment 13

Cause: Device status ok. No active diagnostic errors.
Action: No action required. 

* Lowest priority number equals highest fault severity.
** Both the Siemens standard symbol and its corresponding Namur symbol (from device 
display) will be shown in SIMATIC PDM.

11.3 Fault codes and corrective actions
Alarms and system messages support both Siemens standard alarm classes and NAMUR status 
signals.
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In the following tables the alarm IDs (identification numbers) are listed along with possible 
causes and directions for corrective action.

Sensor diagnostic events
ID/

Sym‐
bols

Diagnostic Action Comments

0 Sensor Sensor startup. Unplug and reconnect the sen‐
sor cable. If the diagnostic persists after the 
specified startup time, restart the device. If the 
problem persists, contact Technical Support.

 

6 DSL DSL internal error. Switch off the power supply 
for 5 seconds. If the problem persists, contact 
Technical Support.

 

7 Sensor Flow measurement error. Switch off the power 
supply for 5 seconds. If the problem persists, 
contact Technical Support.

 

8 DSL DSL internal error. Switch off the power supply 
for 5 seconds. If the problem persists, contact 
Technical Support.

 

14 Measurement path 1 No signal from measurement path 1. Make sure 
the pipe is filled. Check configuration and instal‐
lation of the sensors. Make sure there is enough 
coupling medium.

 

26 Sensor temperature Sensor temperature compensation error. Check 
cabling and configuration of channels 3, 4, 5 and 
6. Check the connected device.

 

28 Invalid configuration Invalid device configuration. One or more of pa‐
rameters are set to invalid values. Review config‐
uration values and adjust as necessary.
If alarm 28 occurs after a correct setup, enable 
the alarm logger and DSL error code logging. 
Provide DSL error codes to service personnel.

 

34 Sensor Flow measurement error. No valid measuring 
signal detected. Check configuration and instal‐
lation of the sensors. Investigate DSL error codes 
to determine the precise root cause.
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ID/
Sym‐
bols

Diagnostic Action Comments

36 Sensor Invalid configuration. Invalid configuration with 
impact on the measurement accuracy detected. 
Check configuration and installation of the sen‐
sors. Check if other diagnostics are active to ex‐
clude hardware errors. If the problem persists, 
contact Technical Support. If alarm 36 occurs af‐
ter a correct setup, enable the alarm logger and 
DSL error code logging. Provide DSL error codes 
to service personnel.

 

37 DSL DSL error. The measurements of the electronics 
temperatures and internal voltages have failed. 
Restart or power the device off and on. If the 
problem persists, contact Technical Support.

 

38 Measurement path Measurement path diagnostic alarm limit excee‐
ded. Adjust the limit for accepted individual 
measurements in menu 2.1.6.8.1.
Enable the alarm logger and DSL error code log‐
ging for DSL error codes 1-4. Check DSL error 
codes 1-4 in menu 3.4.1.8. Provide DSL error co‐
des to service personnel.

 

Transmitter diagnostic events
ID/
Sym‐
bols 

Diagnostic Action Comment

96 Mass flow Mass flow above alarm limit. Check process con‐
ditions. Adjust the parameter value "Upper 
alarm limit" to normal process conditions.

 

97 Mass flow Mass flow above warning limit. Check process 
conditions. Adjust the parameter value "Upper 
warning limit" to normal process conditions.

 

98 Mass flow Mass flow below warning limit. Check process 
conditions. Adjust the parameter value "Lower 
warning limit" to normal process conditions.

 

99 Mass flow Mass flow below alarm limit. Check process con‐
ditions. Adjust the parameter value "Lower 
alarm limit" to normal process conditions.
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ID/
Sym‐
bols 

Diagnostic Action Comment

100 Volume flow Volume flow above alarm limit. Check process 
conditions. Adjust the parameter value "Upper 
alarm limit" to normal process conditions.

 

101 Volume flow Volume flow above warning limit. Check process 
conditions. Adjust the parameter value "Upper 
warning limit" to normal process conditions.

 

102 Volume flow Volume flow below warning limit. Check proc‐
ess conditions. Adjust the parameter value "Low‐
er warning limit" to normal process conditions.

 

103 Volume flow Volume flow below alarm limit. Check process 
conditions. Adjust the parameter value "Lower 
alarm limit" to normal process conditions.

 

104 Density Density above alarm limit. Check process condi‐
tions. Adjust the parameter value "Upper alarm 
limit" to normal process conditions.

 

105 Density Density above warning limit. Check process con‐
ditions. Adjust the parameter value "Upper 
warning limit" to normal process conditions.

 

106 Density Density below warning limit. Check process con‐
ditions. Adjust the parameter value "Lower 
warning limit" to normal process conditions.

 

107 Density Density below alarm limit. Check process condi‐
tions. Adjust the parameter value "Lower alarm 
limit" to normal process conditions.

 

108 Medium temperature Medium temperature above alarm limit. Check 
process conditions. Adjust the parameter value 
"Upper alarm limit" to normal process condi‐
tions.
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ID/
Sym‐
bols 

Diagnostic Action Comment

109 Medium temperature Medium temperature above warning limit. 
Check process conditions. Adjust the parameter 
value "Upper warning limit" to normal process 
conditions.

 

110 Medium temperature Medium temperature below warning limit. 
Check process conditions. Adjust the parameter 
value "Lower warning limit" to normal process 
conditions.

 

111 Medium temperature Medium temperature below alarm limit. Check 
process conditions. Adjust the parameter value 
"Lower alarm limit" to normal process condi‐
tions.+D33:E48

 

136 Totalizer 1 Totalizer 1 above alarm limit. Check process con‐
ditions. Adjust the parameter value "Upper 
alarm limit" to normal process conditions.

 

137 Totalizer 1 Totalizer 1 above warning limit. Check process 
conditions. Adjust the parameter value "Upper 
warning limit" to normal process conditions.

 

138 Totalizer 1 Totalizer 1 below warning limit. Check process 
conditions. Adjust the parameter value "Lower 
warning limit" to normal process conditions.

 

139 Totalizer 1 Totalizer 1 below alarm limit. Check process con‐
ditions. Adjust the parameter value "Lower 
alarm limit" to normal process conditions.

 

148 Transmitter electronics tempera‐
ture

Transmitter electronics temperature too high. 
Decrease the ambient temperature. If possible, 
reposition the device in a different location. In‐
spect the device for heat-related damages.

 

149 Transmitter electronics tempera‐
ture

Transmitter electronics temperature too low. In‐
crease the ambient temperature. If possible, re‐
position the device in a different location. In‐
spect the device for cold-related damages.

 

Diagnostics and troubleshooting
11.3 Fault codes and corrective actions

SITRANS FST020 IP65 (NEMA 4X)
Operating Instructions, 06/2024, A5E41425845-AD 87



ID/
Sym‐
bols 

Diagnostic Action Comment

150 DSL DSL signal disrupted. Switch off the device, wait 
5 seconds and switch it on again. Remote 
mounting: unplug and reconnect the DSL cable. 
If the problem persists, contact Technical Sup‐
port.

 

151 SensorFlash SensorFlash parameter backup disabled. A Sen‐
sorFlash of another device has been inserted. 
Copy the settings from this SensorFlash to the 
device or insert the original SensorFlash.

 

152 SensorFlash SensorFlash parameter backup disabled. A Sen‐
sorFlash of another device has been inserted. 
Copy the settings from this SensorFlash to the 
device or insert the original SensorFlash.

 

160 Mass flow Mass flow simulated. Disable the simulation to 
return to normal operation.

 

161 Volume flow Volume flow simulated. Disable the simulation 
to return to normal operation.

 

162 Density Density simulated. Disable the simulation to re‐
turn to normal operation.

 

163 Medium temperature Medium temperature simulated. Disable the 
simulation to return to normal operation.

 

167 Totalizer 1 Totalizer 1 simulated. Disable the simulation to 
return to normal operation.

 

172 Transmitter Transmitter firmware incompatible. The compo‐
nent does not have the expected firmware ver‐
sion. Update the product firmware or replace the 
component.
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ID/
Sym‐
bols 

Diagnostic Action Comment

173 Sensor Sensor firmware incompatible. The component 
does not have the expected firmware version. 
Update the product firmware or replace the com‐
ponent.

 

174 Local operation Firmware local operation incompatible. The 
component does not have the expected firm‐
ware version. Update the product firmware or 
replace the component.

 

175 I/O electronics I/O firmware incompatible. The component 
does not have the expected firmware version. 
Update the product firmware or replace the com‐
ponent.

 

176 DSL Transmitter and DSL incompatible. The trans‐
mitter is for a different DSL type. Replace the 
DSL.

 

177 Startup Device startup. Wait until the startup is finished. 
The startup time is specified in the operating 
instructions. If the diagnostic persists after the 
specified startup time, restart the device. If the 
problem persists, contact Technical Support.

 

178 Transmitter Transmitter firmware incompatible. The compo‐
nent does not have the expected firmware ver‐
sion. Update the product firmware or replace the 
component.

 

179 Status signals Status signals simulated. Disable the simulation 
to return to normal operation.

No detailed information avail‐
able in view Active diagnostic 
events. Icon depends on simu‐
lated alarm class resp. NAMUR 
status signal and the priority in 
case of multiple alarm classes 
simulated.

180 Transmitter Internal error in transmitter. Restart the device. 
If the problem persists, replace the component.

 

181 SensorFlash SensorFlash error. Replace the SensorFlash.  
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ID/
Sym‐
bols 

Diagnostic Action Comment

182 Transmitter Transmitter firmware incompatible. The compo‐
nent does not have the expected firmware ver‐
sion. Update the product firmware or replace the 
component.

 

195 Channel 2 CH2 loop current in lower saturation. The proc‐
ess value is so low that the loop current reaches 
the lower saturation limit and cannot decrease 
any further. Check process conditions. Adjust 
parameter value "Lower range value".

If Operation mode is config‐
ured to Current output

196 Channel 2 CH2 loop current in upper saturation. The proc‐
ess value is so high that the loop current reaches 
the upper saturation limit and cannot increase 
any further. Check process conditions. Adjust 
parameter value "Upper range value".

If Operation mode is config‐
ured to Current output

197 Channel 21) CH2 cable break. Check current output cable 
connection. Passive operation: check external 
power supply.

If Operation mode is config‐
ured to Current output

210 Channel 4 CH4 output frequency too low. The process val‐
ue is below the parameter "Lower range value". 
The output frequency cannot decrease any fur‐
ther. Check process conditions. Adjust parame‐
ter value "Lower range value".

If Operation mode is config‐
ured to Frequency output

211 Channel 4 CH4 output frequency too high. The process val‐
ue is above the parameter "Upper range value". 
The output frequency cannot increase any fur‐
ther. Check process conditions. Adjust parame‐
ter value "Upper range value".

If Operation mode is config‐
ured to Frequency output

212 Channel 4 CH4 output pulses buffered. Flow too high for 
the pulse output settings. Check process condi‐
tions. Increase the parameter value "Amount", 
or reduce the parameter value "Pulses per 
amount" or "Pulse width".

If Operation mode is config‐
ured to Pulse output

214 Channel 2 CH2 simulated. Disable the simulation to return 
to normal operation.

 

215 Channel 3 CH3 simulated. Disable the simulation to return 
to normal operation.
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ID/
Sym‐
bols 

Diagnostic Action Comment

216 Channel 4 CH4 simulated. Disable the simulation to return 
to normal operation.

 

217 Process values Process values frozen. Freezing of the process 
values is enabled either via a digital input or the 
fieldbus. Disable the freezing of the process val‐
ues to return to normal operation.

 

218 Outputs Output channels forced. Forcing is enabled ei‐
ther via a digital input or the fieldbus. Disable 
forcing to return to normal operation.

 

219 Channel 2 CH2 loop current error. Invalid loop current de‐
viation detected. Check current output cable 
connection. Passive operation: check external 
power supply.

If Operation mode is config‐
ured to Current output

222 Modbus Invalid Modbus register mapping. At least one 
source register has been used multiple times. 
Correct the register mapping.

 

223 Modbus Invalid Modbus coil configuration. A coil has 
multiple assignments. Correct the coil configu‐
rations.

 

224 Energy flow Energy flow above alarm limit. Check process 
conditions. Adjust the parameter value "Upper 
alarm limit" to normal process conditions.

 

225 Energy flow Energy flow above warning limit. Check process 
conditions. Adjust the parameter value "Upper 
warning limit" to normal process conditions.

 

226 Energy flow Energy flow below warning limit. Check process 
conditions. Adjust the parameter value "Lower 
warning limit" to normal process conditions.
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ID/
Sym‐
bols 

Diagnostic Action Comment

227 Energy flow Energy flow below alarm limit. Check process 
conditions. Adjust the parameter value "Lower 
alarm limit" to normal process conditions.

 

228 Sound velocity Sound velocity above alarm limit. Check process 
conditions. Adjust the parameter value "Upper 
alarm limit" to normal process conditions.

 

229 Sound velocity Sound velocity above warning limit. Check proc‐
ess conditions. Adjust the parameter value "Up‐
per warning limit" to normal process conditions.

 

230 Sound velocity Sound velocity below warning limit. Check proc‐
ess conditions. Adjust the parameter value "Low‐
er warning limit" to normal process conditions.

 

231 Sound velocity Sound velocity below alarm limit. Check process 
conditions. Adjust the parameter value "Lower 
alarm limit" to normal process conditions.

 

232 Flow velocity Flow velocity above alarm limit. Check process 
conditions. Adjust the parameter value "Upper 
alarm limit" to normal process conditions.

 

233 Flow velocity Flow velocity above warning limit. Check proc‐
ess conditions. Adjust the parameter value "Up‐
per warning limit" to normal process conditions.

 

234 Flow velocity Flow velocity below warning limit. Check proc‐
ess conditions. Adjust the parameter value "Low‐
er warning limit" to normal process conditions.

 

235 Flow velocity Flow velocity below alarm limit. Check process 
conditions. Adjust the parameter value "Lower 
alarm limit" to normal process conditions.
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ID/
Sym‐
bols 

Diagnostic Action Comment

240 Concentration Concentration above alarm limit. Check process 
conditions. Adjust the parameter value "Upper 
alarm limit" to normal process conditions.

 

241 Concentration Concentration above warning limit. Check proc‐
ess conditions. Adjust the parameter value "Up‐
per warning limit" to normal process conditions.

 

242 Concentration Concentration below warning limit. Check proc‐
ess conditions. Adjust the parameter value "Low‐
er warning limit" to normal process conditions.

 

243 Concentration Concentration below alarm limit. Check process 
conditions. Adjust the parameter value "Lower 
alarm limit" to normal process conditions.

 

244 Kinematic viscosity Kinematic viscosity above alarm limit. Check 
process conditions. Adjust the parameter value 
"Upper alarm limit" to normal process condi‐
tions.

 

245 Kinematic viscosity Kinematic viscosity above warning limit. Check 
process conditions. Adjust the parameter value 
"Upper warning limit" to normal process condi‐
tions.

 

246 Kinematic viscosity Kinematic viscosity below warning limit. Check 
process conditions. Adjust the parameter value 
"Lower warning limit" to normal process condi‐
tions.

 

247 Kinematic viscosity Kinematic viscosity below alarm limit. Check 
process conditions. Adjust the parameter value 
"Lower alarm limit" to normal process condi‐
tions.

 

285 Data logging Data logging, < 30 days remaining. Low availa‐
ble memory, which is full in 30 days at the latest. 
Move data logs from the SensorFlash to an al‐
ternate storage location to free up memory 
space on the SensorFlash. Increase the parame‐
ter value "Logging interval".
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ID/
Sym‐
bols 

Diagnostic Action Comment

286 Data logging Data logging, < 7 days remaining. Low available 
memory, which is full in 7 days at the latest. 
Move data logs from the SensorFlash to an al‐
ternate storage location to free up memory 
space on the SensorFlash. Increase the parame‐
ter value "Logging interval".

 

287 Data logging Data logging memory full. Move data logs from 
the SensorFlash to an alternate storage location 
to free up memory space on the SensorFlash.

 

289 Sound velocity Sound velocity simulated. Disable the simula‐
tion to return to normal operation.

 

290 Flow velocity Flow velocity simulated. Disable the simulation 
to return to normal operation.

 

292 Kinematic viscosity Kinematic viscosity simulated. Disable the sim‐
ulation to return to normal operation.

 

308 Energy flow Energy flow simulated. Disable the simulation to 
return to normal operation.

 

309 Delta temperature Delta temperature simulated. Disable the simu‐
lation to return to normal operation.

 

310 Energy efficiency ratio Energy efficiency ratio simulated. Disable the 
simulation to return to normal operation.

 

311 Coefficient of performance Coefficient of performance simulated. Disable 
the simulation to return to normal operation.
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ID/
Sym‐
bols 

Diagnostic Action Comment

396 Device Maintenance required. Maintenance of device 
should be planned.

 

397 Device Maintenance demanded. Maintenance of de‐
vice should be planned.

 

398 Service Maintenance required. Maintenance of device 
should be planned.

 

399 Service Maintenance demanded. Maintenance of de‐
vice should be planned.

 

400 Calibration Maintenance required. Maintenance of device 
should be planned.

 

401 Calibration Maintenance demanded. Maintenance of de‐
vice should be planned.

 

1) If parameter "Loop current scale" is set to "0…20 mA" and parameter "Fail-safe behavior" is set to "Upper fault current" and the 
cable breaks, this alarm appears intermittently.
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Technical specifications 12
Note
Device specifications
Siemens makes every attempt to ensure the accuracy of these specifications but reserves the 
right to change them at any time.

12.1 Power
Table 12-1 Power supply   
Description Specification
Supply voltage • 100 to 240 V AC +10 / -10%, 47 to 63 Hz

• 11.5 to 28 V DC +10 / -10%
Power consumption • AC = 20 VA

• DC = 10 W
Fluctuation • Transient overvoltages up to the levels of over‐

voltage category II
• Temporary overvoltages occurring on mains 

supply only
Reverse polarity protection (y / n) Y
Galvanic isolation 3000 V AC

12.2 Modbus interface
Table 12-2 Modbus communication   
Description Specification
Protocol version Modbus RTU
Default transmission rate 19200 bit/s
Default parity Even
Default device address 1
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12.3 Inputs
Table 12-3 Digital input
Description Channel 7
Load 15 to 30 V DC, Rin 7 kOhm
Functionality • Reset totalizer

Table 12-4 Digital input 
Description Channel 8
Load 15 to 30 V DC, Rin 7 kOhm
Functionality • Start/Stop totalizer

12.4 Outputs
Table 12-5 Current output
Description Channel 2
Signal range 4 to 20 mA
Resolution 0.4 μA
Load • Ex i: <470 Ω (HART ≥ 230 Ω)

• Non-Ex: <770 Ω (HART ≥ 230 Ω)
Time constant (adjustable) 0.0 to 100 s
Fault current
Measurement range (mA)
Lower fault current (mA)
Upper fault current (mA)

4 - 20 NAMUR
3.8 - 20.5
3.5
22.6

4 - 20 US 
4.0 - 20.8
3.75
22.6

Customized fail-safe mode • Last valid value
– Lower fault current
– Upper fault current

• Fail-safe value
• Current value

Galvanic isolation All inputs and outputs are galvanically isolated PELV circuits with 60 V DC isolation from each 
other and ground.
Maximum test voltage: 500 V AC

Cable Standard industrial signal cable with up to 3 twisted pairs with overall screen can be connected 
between the transmitter and the control system. Individual pair or overall screen is optional 
depending on user requirements.

Voltage range 14 to 30 V DC (passive)

Technical specifications
12.4 Outputs

SITRANS FST020 IP65 (NEMA 4X)
98 Operating Instructions, 06/2024, A5E41425845-AD



12.5 Construction
Table 12-6 Designated use     
Description Specification
Measurement of process medium • Fluid Group 1 (suitable for dangerous fluids)

• Aggregate state: Paste/light slurry, liquid and gas

Table 12-7 System design   
Description Specification
Measuring principle Ultrasonic
System architecture Wall mount housing with all functions integrated in a single pc 

board

Device design

Table 12-8 Wall mount housing transmitter design   
Description Specification
Dimensions See Dimension drawings (Page 101) 
Weight Transmitter: 1.27 kg +/- 0.09 kg (2 lbs 8.8 oz)
Design Wall mount housing
Material Plastic
Ingress protection IP65 NEMA 4X to EN/IEC 60529
Mechanical load 18 to 1000 Hz random, 3.17 g RMS, in all directions, to EN/IEC 

68-2-36

Torques

Table 12-9 Installation torques   
Description Torque (Nm)
Cable gland to housing (Siemens 
supplied, metric, NPT)

10

12.6 Operating conditions
Table 12-10 Basic conditions   
Description Specification
Ambient temperature
(Humidity max. 90 %)

Operation: -10 °C to +50 °C (14 °F to +122 °F)

Ambient temperature
(Humidity max. 90 %)

Storage: -20 °C to +60 °C (-4 °F to +140 °F)

Climate class DIN 60721-3-4

Technical specifications
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Description Specification
Altitude Up to 2000 m (6560 ft)
Relative humidity 95 %
Bump resistance On request
Shock resistance On request
Thermal shock On request
Vibration resistance On request
EMC performance • Emission

• Immunity
• EN 55011 / CISPR-11
• EN/IEC 61326-1 (Industry)

Table 12-11 Process medium conditions
Description Specification
Process medium temperature (Ts) (min to max) -50 °C to +200 °C (-58 °F to 492 °F)
Process medium viscosity Non-compressible liquids

12.7 Approvals
UL 61010-1 3rd Edition CAN/CSA-C22.2 No. 61010-1, 3rd Edition EN61010-1: 2010

12.8 SensorFlash
Table 12-12 SensorFlash     
Description Specification

SD card (S-300u) SD card (Class 4 with adapter)
Capacity min. 4 GB min. 4 GB
File system support FAT32 / 8.3 FAT32 / 8.3
Temperature range
Operation:
Storage:

-40 °C to +85 °C (-40 °F to 185 °F)
-40 °C to +100 °C (-40 °F to 212 °F)

-25 °C to +85 °C (-13 °F to 185 °F)
-40 °C to +85 °C (-40 °F to 185 °F)

Note
SensorFlash functions support
Only the supplied SD cards are supported for backup, restore, logging, and firmware update.
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Dimension drawings 13
13.1 Dimension drawing
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Dimension drawings
13.1 Dimension drawing
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Replacement parts 14
14.1 AC Transmitter exploded view

Replaceable parts

① Enclosure cover w/screws and display - A5E38846901
② Cover with screws - A5E41693888 for AC power supply  / A5E41693889 for DC power supply
③ AC power supply - 7ML18301MD / DC power supply - 7ML18301ME
④ Main board assembly with SD card and firmware - A5E41693884
⑤ SensorFlash Micro SD - A5E38288507
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Note
It is recommended that when replacing the transmitter main board or display board ensure to 
remove original SD-card from transmitter and re-install after new modules have been installed 
in order to recall site parameters.

The following components are not shown:
• Connector plugs
• Power and I/O plugs with Right angle connectors for sensor cables - A5E41693892
• Gland kit - A5E41693895
• Spare battery - A5E41372210

Replacement parts
14.1 AC Transmitter exploded view
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Product Documentation and support A
A.1 Product documentation

Process instrumentation product documentation is available in the following formats: 
• Certificates (http://www.siemens.com/processinstrumentation/certificates)   
• Downloads (firmware, EDDs, software) (http://www.siemens.com/processinstrumentation/

downloads) 
• Catalog and catalog sheets (http://www.siemens.com/processinstrumentation/catalogs) 
• Manuals (http://www.siemens.com/processinstrumentation/documentation) 

You have the option to show, open, save, or configure the manual.
– "Display": Open the manual in HTML5 format
– "Configure": Register and configure the documentation specific to your plant
– "Download": Open or save the manual in PDF format
– "Download as html5, only PC": Open or save the manual in the HTML5 view on your PC

You can also find manuals with the Mobile app at Industry Online Support (https://
support.industry.siemens.com/cs/ww/en/sc/2067). Download the app to your mobile device 
and scan the device ID link.

Product documentation by serial number
Using the PIA Life Cycle Portal, you can access the serial number-specific product information 
including technical specifications, spare parts, calibration data, or factory certificates.

Entering a serial number
1. Open the PIA Life Cycle Portal (https://www.pia-portal.automation.siemens.com).
2. Select the desired language.
3. Enter the serial number of your device. The product documentation relevant for your device 

is displayed and can be downloaded.
To display factory certificates, if available, log in to the PIA Life Cycle Portal using your login 
or register.

Scanning an ID link
1. Scan the ID link on your device with a mobile device.
2. Click "PIA Portal".
To display factory certificates, if available, log in to the PIA Life Cycle Portal using your login 
or register.
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A.2 Technical support

Technical support
If this documentation does not completely answer your technical questions, you can enter a 
Support Request (http://www.siemens.com/automation/support-request). 
For help creating a support request, view this video here (www.siemens.com/opensr). 
Additional information on our technical support can be found at Technical Support (http://
www.siemens.com/automation/csi/service).   

Service & support on the Internet 
In addition to our technical support, Siemens offers comprehensive online services at service & 
support (http://www.siemens.com/automation/serviceandsupport).

Contact 
If you have further questions about the device, contact your local Siemens representative, by 
doing the following: 
1. Visit Contact at Siemens (http://www.automation.siemens.com/partner).
2. Select "All Products and Branches" > "Products & Services" > "Industrial automation".
3. Choose either "Process analytics" or "Process instrumentation", depending on your product.
4. Select the product category ("Pressure measurement", for example), then select your 

product.
5. Click "Search".

The contacts for your product in all regions display.

Contact address for business unit: 
Siemens AG
Digital Industries
Process Automation
Östliche Rheinbrückenstr. 50 
76187 Karlsruhe, Germany

Product Documentation and support
A.2 Technical support
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Communication B
B.1 Modbus communication

B.1.1 Modbus addressing model
The device allows read/write access to the following standard Modbus RTU data holding register 
blocks:
• Holding registers (ref. 4x address range)
The minimum value of a writable holding register can be read by adding 10000 to the 
Modbus address of the register.
The maximum value of a writable holding register can be read by adding 20000 to the 
Modbus address of the register.
The default value of a writable holding register can be read by adding 30000 to the Modbus 
address of the register.

B.1.2 Modbus function codes
This device supports following function codes: 3, 8 and 16.
Function codes 3 and 16 are used for accessing registers, max. 16 registers per read/write 
request is accepted.
Function code 8 is used for reading Modbus communication diagnostic information.
Below the various function code are described.

Function code 3 (Read holding registers)
General exceptions:
• Requesting less than 1 or more than 16 registers => Exception 3 (Illegal data value)
• Requesting invalid start address or start address with invalid quantity => Exception 2 (Illegal 

data address)

Application exceptions:
• Application errors; min/max limit of parameter exceeded; or parameter write-protected => 

Exception 4 (Slave device error)
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Holes/register alignment:
• The read command always returns data if no exception is given.
• Holes in the holding register map return value zero in all bytes. E.g. reading 2 registers 

starting at 4:0004 above will result in 2 bytes of "float B" followed by 2 zeroes.

Function code 3 example
Query
Slave address 1 byte
Function 1 byte
Starting Address Hi 1 byte
Starting Address Lo 1 byte
Quantity of Registers Hi 1 byte
Quantity of Registers Lo 1 byte
CRC 2 bytes

Response
Slave address 1 byte
Function 1 byte
Byte count 1 byte
Register Value Hi 1 byte
Register Value Lo 1 byte
: :
Register Value Hi 1 byte
Register Value Lo 1 byte
CRC 2 bytes

Example: Read absolute massflow (address 3000)
Query: 1,3,11,184,0,2,70,10
Slave address  = 1 (0x01)
Function = 3 (0x03)
Starting Address Hi, Lo = 11, 184 (0x0B,0xB8)
Quantity of Registers Hi , Lo = 0, 2 (0x00,0x02) 
CRC  = 70,10 (0x46, 0x0A)
Starting address 0x0BB8 = 3000
Quantity of registers = 0x0002 = 2
Response: 1,3,4,64,195,82,139,98,200
Slave address  = 1 (0x01)
Function = 3 (0x03)
Byte Count  = 4 (0x04)
Register 1 - Register Value Hi, Lo = 64, 195 (0x40, 0xC3)
Register 2 - Register Value Hi, Lo = 82, 139 (0x52,  0x93)
CRC  = 98,200 (0x62, 0xC8)
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Absolute mass flow = 0x40C35293 = 6.10383 kg/sec

Function code 16 (Write multiple registers)
General exceptions
• Writing less than 1 or more than 16 registers => Exception 3 (Illegal data value)
• If ByteCount is not exactly 2 times NoOfRegisters => Exception 3 (Illegal data value)
• Requesting invalid start address or start address with invalid quantity => Exception 2 (Illegal 

data address)

Application exceptions:
• Application errors; min/max limit of parameter exceeded; or parameter write-protected => 

Exception 4 (Slave device error)
• Application errors include writing to ReadOnly holding registers

Holes/register alignment:
• If start-address is not the start of a mapped holding register => Exception 2 (Illegal data 

address)
• Writing to holes is allowed (ie ignored - and no exception occurs) - except for the condition 

described above
• If the end address is only part of a mapped holding register item (e.g. one half of a float 

value), the action depends on the data type. Writing parts of all data types => Exception 4 
(Slave device error)

Function code 16 example
Query
Slave address 1 byte
Function 1 byte
Starting Address Hi 1 byte
Starting Address Lo 1 byte
Quantity of Registers Hi 1 byte
Quantity of Registers Lo 1 byte
Byte Count 1 byte
Registers Value Hi 1 byte
Registers Value Lo 1 byte
: :
Registers Value Hi 1 byte
Registers Value Lo 1 byte
CRC 2 bytes

Communication
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Response
Slave address 1 byte
Function 1 byte
Starting Address Hi 1 byte
Starting Address Lo 1 byte
Quantity of Registers Hi 1 byte
Quantity of Registers Lo 1 byte
CRC 2 bytes

Example: Set baud rate to 115200 baud (address 529)
Query: 1,16,2,17,0,1,2,0,5,70,210
Slave address  = 1 (0x01)
Function = 16 (0x10)
Starting Address Hi, Lo = 2, 17 (0x02,0x11)  
Quantity of Registers Hi, Lo = 0, 1 (0x00,0x01)
Byte Count  = 2 (0x02)
Registers Value Hi, Lo = 0, 5 (0x00,0x05)
CRC  = 70,10 (0x46, 0x0A)
Starting address 0x0211 = 529
Number of registers = 0x0001 = 1
Data 0x0005 = (115200 = value 5)
Response: 1,16,2,17,0,1,80,116
Slave address  = 1 (0x01)
Function = 16 (0x10)
Starting Address Hi, Lo = 2, 17 (0x02,0x11)
Quantity of Registers Hi, Lo = 0, 1 (0x00,0x01) 
CRC = 80,116 (0x50, 0x74)

Function code 8 (Diagnostics)
Modbus function code 8 provides a series of tests for checking the communication system 
between a client (Master) device and a server (Slave).
The following diagnostics functions are supported:

Sub-
func‐
tion 
code 
(Dec)

Name Description

00 Return Query Data The data passed in the request data field is to be returned 
(looped back) in the response.

10 Clear Counters and Diagnostic 
Register

Clears all counters and the diagnostic register. Counters are 
also cleared upon power–up.

11 Return Bus Message Count The response data field returns the quantity of messages that 
the remote device has detected on the communications sys‐
tem since its last restart, clear counters execution, or power–
up.

Communication
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Sub-
func‐
tion 
code 
(Dec)

Name Description

12 Return Bus Communication Er‐
ror Count

The response data field returns the quantity of CRC errors en‐
countered by the remote device since its last restart, clear 
counters execution, or power–up.

13 Return Bus Exception Error 
Count

The response data field returns the quantity of MODBUS ex‐
ception responses returned by the remote device since its last 
restart, clear counters execution, or power–up.

14 Return Slave Message Count The response data field returns the quantity of messages 
broadcast or addressed to the remote device that the remote 
device has processed since its last restart, clear counters exe‐
cution, or power–up.

15 Return Slave No Response 
Count

The response data field returns the quantity of messages ad‐
dressed to the remote device for which it has returned no 
response (neither a normal response nor an exception re‐
sponse), since its last restart, clear counters execution, or 
power–up.

16 Return Slave NAK Count The response data field returns the quantity of messages ad‐
dressed to the remote device for which it returned a Negative 
Acknowledge (NAK) exception response, since its last restart, 
clear counters execution, or power–up.

17 Return Slave Busy Count The response data field returns the quantity of messages ad‐
dressed to the remote device for which it returned a Slave 
Device Busy exception response, since its last restart, clear 
counters execution, or power–up.

18 Return Bus Character Overrun 
Count

The response data field returns the quantity of messages ad‐
dressed to the remote device that it could not handle due to a 
character overrun condition, since its last restart, clear coun‐
ters execution, or power–up.

20 Clear Overrun Counter and Flag Clears the overrun error counter and resets the error flag.

Function code 8 example
Query
Slave address 1 byte
Function 1 byte
Sub-function Hi 1 byte
Sub-function Lo 1 byte
Data Hi 1 byte
Data Lo 1 byte
: :
Data Hi 1 byte
Data Lo 1 byte
CRC 2 bytes
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Response
Slave address 1 byte
Function 1 byte
Sub-function Hi 1 byte
Sub-function Lo 1 byte
Data Hi 1 byte
Data Lo 1 byte
: :
Data Hi 1 byte
Data Lo 1 byte
CRC 2 bytes

Example: Read Return Slave Message Count (address 529)
Query: 1,8,0,14,0,0,129,200
Slave address  = 1 (0x01)
Function = 8 (0x08)
Sub-function Hi, Lo = 0, 14 (0x00,0x0E)
Data Hi, Lo = 0, 0 (0x00,0x00)
CRC  = 129,200 (0x81, 0xC8)
Sub-function 0x000E = 14 = Read Return Slave Message Count
Response: 1,8,0,14,0,97,64,32
Slave address  = 1 (0x01)
Function = 8 (0x08)
Sub-function Hi, Lo = 0, 14 (0x00,0x0E)
Data Hi, Lo = 0, 97 (0x00,0x65)
CRC  =  64,32 (0x41, 0xE3)
Read Return Slave Message Count = 0x0065 = 97 message received

Communication
B.1 Modbus communication

SITRANS FST020 IP65 (NEMA 4X)
112 Operating Instructions, 06/2024, A5E41425845-AD



B.1.3 Changing Modbus communication settings
Changing communication parameters, for example Baud Rate, Modbus Parity Framing or Bus 
Address effects the Modbus communication as follows:
• The new settings have effect only after a reset, either by restarting the device or writing the 

value 1 to Modbus address 600 Restart communication. 
• The new settings will not have effect until the Modbus driver has responded to any ongoing 

Modbus request.
NOTICE
Setting addresses in a multidrop network
It is recommended NOT to use the default address in a multi-drop network. When setting 
device addresses, make sure that each device has a unique address. Replication of addresses 
may cause abnormal behavior of the entire serial bus and make the master unable to 
communicate with all slaves on the bus.  

B.1.4 Modbus communication

Table B-1 General Modbus settings   
Modbus 
register

Data type / 
Size in 
bytes

Parameter Description Default 
value 
[units]
(units
register)

Value range / 
Setting options

Access 
level

8291 Unsigned / 
2

Restart com‐
munication

Restarts the communication using 
configured slave address, baud rate 
and parity/framing.

- • 0: Cancel
• 1: Restart

Write only

8005 Unsigned / 
2

Slave address 
(HW)

DIP switch setting on the transmitter 
cassette. Address is used if DIP switch 
is set to a value > 0.

- - Read only

8297 Unsigned / 
2

Slave address 
(SW)

Software address of Modbus inter‐
face. Address is used if switch is set to 
0.

1 1 - 147 Read / 
write
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Modbus 
register

Data type / 
Size in 
bytes

Parameter Description Default 
value 
[units]
(units
register)

Value range / 
Setting options

Access 
level

8298 Unsigned / 
2

Baud rate Baud rate of Modbus interface. 19200 Bit/s • 0: 9600 Bit/s
• 1: 19200 

Bit/s
• 2: 115200 

Bit/s
• 3: Reserved
• 4: 38400 

Bit/s
• 5: 57600 

Bit/s
• 6: 76800 

Bit/s
• 7: 1200 Bit/s
• 8: 2400 Bit/s
• 9: 4800 Bit/s

Read / 
write

8299 Unsigned / 
2

Parity and fram‐
ing

Parity and framing of the Modbus 
communication interface.

Even pari‐
ty, 1 stop

• 0: Even pari‐
ty, 1 stop

• 1: Odd pari‐
ty, 1 stop

• 2: No parity, 
2 stops

• 3: No parity, 
1 stop

Read / 
write
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B.1.5 Coil configuration
The device provides 20 coil definitions which can be configured. 

Table B-2 Coil configuration   
Modbus 
register

Data type / 
Size in bytes

Parameter Description Default value 
[units] 1

(units regis‐
ter)

Value range / 
Setting options

Access lev‐
el

10300 Unsigned / 2 Modbus coil ad‐
dress 1

Specifies the coil address with 
which the following bit coded 
register value is accessible. 
The register and bit(s) are 
specified by Modbus coil regis‐
ter 1and Modbus coil bitmask 
1

1 0 - 65535 Read / write

10301 Unsigned / 2 Modbus coil reg‐
ister 1

Specifies the Modbus register 
whose value is checked 
against Modbus coil bitmask 1 
to determine the coil value 
(false or true). A register value 
of 65535 specifies that this coil 
mapping is undefined.

Undefined 0 - 65535 Read / write

10302 Unsigned / 4 Modbus coil bit‐
mask 1

Bit mask which is compared 
against the register value 
specified with Modbus coil reg‐
ister 1 to determine the coil 
value. If any bit of the register 
value is set which is also set in 
the bit mask then the coil value 
is true, otherwise the coil is 
false.

0 0 - 4294967295 Read / write

10304 Unsigned / 2 Modbus coil 
length 1

Output parameter that in‐
forms about the size in bytes of 
the parameter that is specified 
by Modbus coil address 1. 
Could be used to identify the 
relevant bits of the Modbus 
coil bitmask 1

-   Read only

10305 Unsigned / 2 Modbus coil ad‐
dress 2

Specifies the coil address with 
which the following bit coded 
register value is accessible. 
The register and bit(s) are 
specified by Modbus coil regis‐
ter 2 and Modbus coil bitmask 
2

2 0 - 65535 Read / write

10306 Unsigned / 2 Modbus coil reg‐
ister 2

Specifies the Modbus register 
whose value is checked 
against Modbus coil bitmask 2 
to determine the coil value 
(false or true). A register value 
of 65535 specifies that this coil 
mapping is undefined.

Undefined   Read / write
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Modbus 
register

Data type / 
Size in bytes

Parameter Description Default value 
[units] 1
(units regis‐
ter)

Value range / 
Setting options

Access lev‐
el

10307 Unsigned / 4 Modbus coil bit‐
mask 2

Bit mask which is compared 
against the register value 
specified with Modbus coil reg‐
ister 2 to determine the coil 
value. If any bit of the register 
value is set which is also set in 
the bit mask then the coil value 
is true otherwise false.

0 0 - 4294967295 Read / write

10309 Unsigned / 2 Modbus coil 
length 2

Output parameter that in‐
forms about size in bytes of pa‐
rameter that is specified by 
Modbus coil address 2. Could 
be used to identify the rele‐
vant bits of the Modbus coil 
bitmask 2

-   Read only

...
10399 Unsigned / 2 Modbus coil 

length 20
Output parameter that in‐
forms about the size in bytes of 
the parameter that is specified 
by Modbus coil address 20. 
Could be used to identify the 
relevant bits of the Modbus 
coil bitmask 20

-   Read only

1 If default value is "-" the command "Set to default" will not set this parameter to default.  

B.1.6 Modbus register mapping
The device provides the possibility to map each existing parameter to a freely chosen Modbus 
register for communication purposes over channel 1.
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The device provides means to remap 20 Modbus registers.

Table B-3 Modbus register mapping   
Modbus 
register

Data type / 
Size in 
bytes

Parameter Description Default value 
[units]
(units regis‐
ter)

Value range / 
Setting op‐
tions

Access 
level

10448 Unsigned / 4 Enable mapping Activation/deactivation of 
the register mapping. A set 
bit means that the mapping 
pair is activated, a cleared bit 
that the mapping pair is de‐
activated.
Bit 0:
Requested register 1 / Target 
register 1
…
Bit 19:
Requested register 20 / Tar‐
get register 20

0 0 - 1048575 Read / 
write

10450 Unsigned / 2 Register 1 source Modbus register that ap‐
pears within Modbus request 
is redirected to the parame‐
ter specified by Target regis‐
ter 1

65535 0 - 65535 Read / 
write

10451 Unsigned / 2 Register 1 target Register of an existing prod‐
uct parameter to which a 
Modbus request is redirected

65535 0 - 65535 Read / 
write

...
10488 Unsigned / 2 Register 20 source Modbus register that ap‐

pears within Modbus request 
is redirected to the parame‐
ter specified by Target regis‐
ter 20

65535 0 - 65535 Read / 
write

10489 Unsigned / 2 Register 20 target Register of an existing prod‐
uct parameter to which a 
Modbus request is redirected

65535 0 - 65535 Read / 
write
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B.1.7 Integer byte order
The device is able to adjust the byte order of integer values. 

Table B-4 Integer byte order   
Modbus 
register

Data type / 
Size in 
bytes

Parameter Description Default value 
[units]
(units regis‐
ter)

Value range / 
Setting op‐
tions

Access 
level

8295 Unsigned / 2 Integer order byte The integer byte order used 
in Modbus messages.
0: MSB - LSB (big endian)
1: LSB - MSB (little endian)
MSB = most significant byte / 
high byte
LSB = least significant byte / 
low byte

MSB - LSB (big 
endian)

0 - 1 Read / 
write

B.1.8 Float byte order
The device is able to adjust the byte order of floating-point values. 

Table B-5 Float byte order    
Modbus 
register

Data type / 
Size in 
bytes

Parameter Description Default value 
[units]
(units regis‐
ter)

Value range / 
Setting op‐
tions

Access 
level

8296 Unsigned / 2 Float byte order The float byte order used in 
Modbus messages.
0: 1-0-3-2
1: 0-1-2-3
2: 2-3-0-1
3: 3-2-1-0
The first mentioned byte is 
the first byte sent. 
Byte 3 corresponds to the 
left-most byte (MSB) of a 32 
bit floating point number in 
big endian format, byte 0 to 
the right-most byte

3-2-1-0 0 - 3 Read / 
write
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B.1.9 Modbus function codes

Table B-6 General Modbus settings   
Function code Command text Description
01 Read Coils Reads the status of single bit(s)
02 Read Discrete Inputs Reads the status of single input bit(s)
03 Read Holding Registers Reads the binary content of multiple 16-bit registers
04 Read Input Registers Reads the binary content of multiple 16-bit registers
05 Write Single Coil Writes a single on/off bit
06 Write Single Register Writes the binary content of single 16-bit register
07 Read Exception Status Delivers the global alarm status of the device
08 Diagnostics Provides a series of tests for checking the communication system
15 Write Multiple Coils Writes multiple on/off bits
16 Write Multiple Registers Writes the binary content of multiple 16-bit registers
17 Report Slave ID The device will respond to a Report Slave ID command (com‐

mand 17) request from the master by giving information about 
device type, vendor, and revision level

23 Read/Write Multiple Registers Combined Write Multiple Registers / Read Holding Registers call

Function code 7 (Read exception status) 
The device provides the content of the parameter Global alarm status as exceptions. 

Function code 8 (Diagnostics) 
The diagnostics function provides means for checking the communication between MODBUS 
master and slave. The function uses a sub-function code to select the functionality.
The following sub-function codes are supported:

Sub-function code Name Description
0 Return query data The data passed in the request data field will be returned (looped 

back) in the response. The entire response message should be 
identical to the request.

1 Restart communications option After having restarted the communication, select the baudrate, 
framing or Modbus address to get access to the device again.

Function code 17 (Report Slave ID) 
The transmitter will respond to a Report Slave ID request from the master by giving 
information about device type, vendor, and firmware version in a format as shown:
Response

Slave address 1 byte  
Function code 1 byte 17
Byte count 1 byte 62
Slave ID 1 byte Sensor device type

0: SITRANS FS
Run indicator 1 byte 255: Running
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Manufacturer name 12 bytes SIEMENS
Product name 32 bytes SITRANS F
Product firmware 
version

16 bytes -

CRC 2 bytes  

B.1.10 Access control
Access control manages whether the Modbus master is allowed to modify device parameters. 
Reading of parameters is always possible. The general access control rules are:
• The Modbus interface has an access level that can be changed by providing PIN information 

via the Modbus register 8292 (User PIN) or 8293 (Expert PIN).
• The default fieldbus access level can be set using Modbus register 6348, with the following 

possible values:
– 32: End User Privilege 
– 16: Restricted User Privilege

• Each parameter has a protection level assigned that specifies the required access level to 
modify the parameter via the Modbus interface.

• If the access level of the Modbus interface is lower than the protection level of the parameter 
that is desired to be modified, then the attempt to modify the parameter is rejected by the 
device.

If the device is defined as a custody transfer (CT) device and the CT write protection DIP 
switch is ON (locked), the device will deny all writes to CT parameters independent of the 
access control.

Table B-7 Access control   
Access level Description
Read only The Modbus master is not able to modify the device configuration (setup parameters).

The Modbus master is only able to execute the command, to reset PINs.
This is the default level of the Modbus interface.

User The Modbus master has to provide the correct user PIN with Modbus register 8292 to reach this access 
level.
The Modbus master is able to modify a subset of the device configuration.

Expert The Modbus master has to provide the correct expert PIN with Modbus register 8293 to reach this access 
level.  The Modbus master is able to modify the configuration of the device.

If an incorrect user PIN or an incorrect expert PIN is entered, or if the device does not receive 
any request within 10 minutes, the device resets the access level to read only. 

Communication
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Remote Operation C
C.1 Commissioning with SIMATIC PDM

C.1.1 Overview SIMATIC PDM
SIMATIC PDM (Process Device Manager) is a general-purpose, manufacturer-independent tool 
for the configuration, parameter assignment, commissioning, diagnostics and maintenance of 
intelligent field devices and field components. Follow-up installations and additional 
information on SIMATIC PDM are available on the Internet at SIMATIC PDM (https://
www.siemens.com/simatic-pdm).
SIMATIC PDM monitors the process values, alarms and status signals of the device. It 
allows you to display, compare, adjust, verify, and simulate process device data; also to set 
schedules for calibration and maintenance.
For information on, for example, how to install and integrate devices, commission 
the software, see Operating Manual 'Help for SIMATIC PDM'. The manual is delivered 
with SIMATIC PDM software. Once the SIMATIC PDM is installed on your computer 
you find the manual under: Start > All programs > Siemens Automation > SIMATIC 
> Documentation. Link at our website: SIMATIC PDM instructions and manuals (https://
support.industry.siemens.com/cs/ww/en/ps/16983/man).

Note
Field device parameters
• For a list of parameters and additional information, consult section "Parameters accessed via 

PDM menus (Page 132)".
• The field device remains in measurement mode during the time you configure the field 

device.

C.1.2 Check SIMATIC PDM version

Procedure
1. Go to Software downloads (https://www.siemens.com/processinstrumentation/downloads).
2. Check the support page to make sure you have:

– The latest version of SIMATIC PDM
– The most recent Service Pack (SP)
– The most recent hot fix (HF)
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C.1.3 Deactivate buffers when connecting via serial modem

Introduction
This deactivation is required to align SIMATIC PDM with the HART modem when using a 
Microsoft Windows operating systems.
Deactivating buffers is not necessary when connecting via USB.

Condition
• You connect via RS232 (COM1).
• You have administrative rights on your operating system.
• You know the hardware and software requirements SIMATIC PDM installation 

documentation.

Procedure
1. Check the Operating Instructions for SIMATIC PDM for hardware and software requirements.
2. From the computer desktop, click "Start > Control Panel" to begin configuration.
3. Click "System and Security".
4. Select "Device Manager" under "System".
5. Open folder "Ports".
6. Double click the COM Port used by the system to open the properties window.
7. Select the tab "Port Settings".
8. Click the "Advanced" button.

If the "Use FIFO buffers" radio box is selected, click to deselect.

① Deselect "Use FIFO buffers" radio box

9. Click "OK" button to close out.
10.Close all screens.
11.Restart the computer.

Remote Operation
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C.1.4 Updating the Electronic Device Description (EDD) or Field Device 
Integration (FDI)

Procedure
1. Check that the EDD or FDI revision match the Firmware revision in the device according to the 

table in section Product compatibility (Page 9).
2. Go to the support page Software downloads (https://www.siemens.com/

processinstrumentation/downloads).
3. Enter the product name in the field "Enter search term...".
4. Download the most current EDD or FDI of your device.
5. Save files to your computer in an easily accessed location.
6. Launch SIMATIC PDM – Device Integration Manager.

From the File menu, click "Read device descriptions from compressed source...".
7. Browse to the compressed EDD or FDI files, select and open it. 
8. From the Catalog menu, use the "Integration" function to integrate the EDD or FDI into the 

device catalog. The EDD or FDI is now accessible via SIMATIC Manager.
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C.1.5 Adding device to communication network
Before setting the parameters, it is necessary to configure the project in PDM. 
1. Add the device to SIMATIC Modbus network: 

– Open the project in the process device network view.
– Right click on Networks and select Insert New Object → Communication network.

The Insert Object(s) - <...> dialog box opens.
– Click on Assign Device Type.
– Select the inserted Modbus network in the right window and right-click.
– Select the Object Properties command.
– Enter the device-specific information in the Communication tab of the Properties dialog 

for the Modbus network.

Modbus communication type: Serial or IrDA (infrared)
Serial The interface must be set accordingly on the PC station.
IrDA No additional setting required.

Once the device is within range, it is available for Modbus communication.
Only one infrared device can be coupled to Modbus at a given time. Several devices 
can be coupled under Windows.

Response 
time

General timeout within which the device is allowed to report. If the timeout is too 
long, the communication is slowed. If it is too short, some devices may not be 
found.

Figure C-1 Assigning Modbus device to network
– To check if the correct network and the correct port are assigned to the COM interface, 

double-click the PC object in the right window. Select the COM interface object in HW 
Config, and select the Object Properties menu command in the shortcut menu.

2. Set up the COM interface:
– To insert the Modbus device, select the Modbus network object in the right window and 

right-click. In the displayed shortcut menu, select the Insert New Object → Object 
command. In the displayed dialog box, enter the name of the Modbus device

– To set the device address, select the inserted Modbus device in the right window and right-
click. Select the Object Properties command in the displayed shortcut menu.

– Enter the device-specific information (Modbus address 0-247) in the Communication tab 
of the Properties dialog for the Modbus device.
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– To change the device address, select the inserted Modbus device in the right window and 
then select the Object Properties menu command in the shortcut menu. Select the 
Communication tab in the displayed dialog and enter the new short address.

– Start SIMATIC PDM by double-clicking the newly inserted Modbus device in the right 
window. Select the relevant device in the menu tree (only required for the first call), and 
assign parameters for the device.

Figure C-2 Set COM port

Note
Multiple PCs in one project
If there are several PCs in your project, you have to define one of them as the current one. To do 
this, select the desired PC object in the left window and then select the menu command Options 
→ Define Current PC.

C.1.6 Integrating a HART device in a HART modem network

Figure C-3 HART modem
The following describes how to integrate a HART device in a HART modem network.

Requirements
• A project has been created.
• An access point of the computer is set to the COM port to which the HART modem network 

is connected.
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Integrating a HART device in a HART modem network
1. Open the project in the process device network view.
2. Right-click the "Networks" object in the tree structure. In the shortcut menu that opens, select 

the menu command Insert New Object > Communication network. The "Insert Object(s) - 
<...>" dialog box opens.

3. Click the "Assign Device Type" button.
The "Insert Object(s) - Assign Device Type" dialog box opens. You can find additional 
information in the section "Insert Object - Assign Device Type" dialog box.

4. To set the network properties, select the inserted HART modem network in the right window 
and right-click. Select the Object Properties command in the displayed shortcut menu.

5. Enter the device-specific information in the "Communication" tab of the Properties dialog for 
the HART modem network.
Set the master type (primary or secondary, usually secondary):
Here, you can select the "Prefer 'Long address'" check box.

Modbus communication type: Serial or IrDA (infrared)
Serial The interface must be set accordingly on the PC station.
IrDA No additional setting required.

Once the device is within range, it is available for Modbus communication.
Only one infrared device can be coupled to Modbus at a given time. Several devices 
can be coupled under Windows.

Response 
time

General timeout within which the device is allowed to report. If the timeout is too 
long, the communication is slowed. If it is too short, some devices may not be found.

Figure C-4 Assigning HART device to network
6. To check if the correct network and the correct port are assigned to the COM interface, 

double-click the PC object in the right window. Select the COM interface object in HW 
Config, and select the Object Properties menu command in the shortcut menu.
Note
The COM port is almost always "1" for notebooks. Since most PCs have two COM ports, you 
must specify the port to which the HART modem is connected in this tab. Check whether the 
settings for the FIFO buffer of the COM port are suitable, or immediately use a USB HART 
modem.

7. To insert the HART device, select the HART modem Modbus network object in the right 
window and right-click. In the displayed shortcut menu, select the Insert New Object → 
Object command.
In the displayed dialog box, enter the name of the HART device
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8. To set the device address, select the inserted Modbus device in the right window and right-
click. Select the Object Properties command in the displayed shortcut menu.

9. Enter the device-specific information (Modbus address 0-247) in the Communication tab of 
the Properties dialog for the HART device.
Note
Address with HART
• The short address must be entered for HART devices. This address must correspond to the 

connected HART device. The short address is always "0", unless the device is in the multi-
drop function.

• For a HART interface, enter the long address. This address contains the following device-
specific information:
– Manufacturer
– Device type
– Device name

10.To change the device address, select the inserted HART device in the right window and then 
select the Object properties menu command in the shortcut menu. Select the 
"Communication" tab in the displayed dialog and enter the new short address.
Note
The address must correspond to the connected device. The short address for HART devices is 
always "0" unless the device is in the multi-drop function.

11.Start SIMATIC PDM by double-clicking the newly inserted HART device in the right window. 
Select the relevant device in the menu tree (only required for the first call), and assign 
parameters for the device.

Figure C-5 Set COM port

Note
Multiple PCs in one project
If there are several PCs in your project, you have to define one of them as the current one. To do 
this, select the desired PC object in the left window and then select the menu command Options 
→ Define Current PC.
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C.1.7 Configuring a new device

Note
Configuring device via SIMATIC PDM
Clicking "Cancel" button during an upload from device to SIMATIC PDM will result in some 
parameters being updated.

1. Check that you have the most recent EDD, and if necessary update it. See Updating the 
Electronic Device Description (EDD) or Field Device Integration (FDI) (Page 123).

2. Launch SIMATIC Manager and create a new project for the device. 
3. Open the menu "Device > Operation > Reset > Restore ordered configuration". Select "Yes" 

button and click "OK" to perform a reset to customer ordered settings.
4. After the reset is complete click on “Upload to PG/PC…” to customer ordered settings.
5. Configure the device via the Quick Start wizard. (See Wizard - Quick Start via PDM (Page 128).)

C.1.8 Wizard - Quick Start via PDM
The graphic Quick Start Wizard provides an easy multistep procedure that configures the device 
for a simple application.
Please consult the SIMATIC PDM operating instructions or online help for details on using 
SIMATIC PDM.

Quick start

Note
• The Quick Start wizard settings are inter-related and changes apply only after you click on 

Apply at the end of the wizard to transfer settings to the device.
• Do not use the Quick Start Wizard to modify individual parameters.
• Click on Back to return and revise settings or Cancel to exit the Quick Start.

Launch SIMATIC PDM, open the menu Device → Wizards → Wizard - Quick Start..., and follow 
the steps.
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C.1.9 Wizard - Clamp-On Configuration
Open the menu Device → Wizards → Wizard - Clamp-On Configuration..., and follow the steps.

The clamp-on configuration wizard takes the user through the necessary steps to install the 
sensors to achieve proper operation.

C.1.10 Zero point adjustment
Open the menu Device → Operation → Zero point adjustment, and follow the steps.
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Although the device zero is very stable from the factory the user has the ability to remove 
any residual zero offset that may exist by performing the Zero point adjustment.

C.1.11 Changing parameter settings using SIMATIC PDM
SIMATIC PDM monitors the process values, alarms and status signals of the device. It allows you 
to display, compare, adjust, verify, and simulate process device data; also to set schedules for 
calibration and maintenance.
Parameters in SIMATIC PDM are identified by name and organized into function groups, 
similar to the structure of the local display (HMI). 
Within SIMATIC PDM, parameters can be found in a structured view (which can be accessed 
when the device is offline), or in the PDM menus (when device is online): Device, View, 
Diagnostics.  
See:
• SIMATIC PDM structure view image (Page 132)
• Parameters accessed via PDM menus (Page 132)

Note
• Clicking button "Cancel"  during an upload from device to SIMATIC PDM will result in some 

parameters being updated.
• While the device is in Edit view the output remains active and continues to respond to 

changes in the device.

1. Launch SIMATIC PDM, connect to device, and upload data from device. 
2. Adjust parameter values in the parameter value field then press "Enter" key. The status fields 

read "Changed".
3. Open the Device menu, click "Download to device...".  When complete, use "File > Save" to 

save settings offline. The status fields are cleared.
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C.1.12 SIMATIC PDM structure view image

① Structure view (offline table)
② Value fields

C.1.13 Parameters accessed via PDM menus
Click on "Device", "View", or "Diagnostics" to open the associated PDM menu.

① PDM menus
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PDM menus
Device View Diagnostics
Download to device
Upload to PC/PG

Process values Update diagnostics

Assign address and Tag...
Value comparison...
Object properties...
Calibration log...
Change Log...
Set evice checked...

Start Life List... Alarms
Advanced diagnostics
Receiver signal

Check configuration...
Templates

   

Identification    
Wizards
Operation

   

Setup
Maintenance and diagnostics

   

Communication
Security
Characteristics
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C.1.14 Process variables
1. To compare outputs in real time select View → Process variables to see all process values, 

totalizers and loop current.
2. Verify that the process values show the expected values.

Trend view
Open the menu View → Process variables and click on a Trend view button to monitor the trend 
of one or all process values available at each tab.

C.2 Diagnosing with PDM
SIMATIC PDM is a suitable tool for diagnosing the device. 
You can use SIMATIC PDM to read all available parameters to a table for analyzing offline, 
view online/actual process values and online/actual diagnostic information.   

Requirements
Online diagnostic information is available under menu View → Device Status.
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The following procedure must be completed before diagnosing:
• Installation of PDM and PDM device driver 
• Connection of HART interface
Refer to Commissioning with SIMATIC PDM (Page 121).
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HMI menu structure D
D.1 HMI menu structure

An overview of the HMI menu structure is available for download under this link (https://
support.industry.siemens.com/cs/ww/en/view/109954689).

Note
Visibility of menus/parameters
The visibility of some parameter/menu items depends on previous selections. For example, if 
Frequency is selected on the output, only the frequency setup parameter/menu items are visible. 
The parameter/menu items for setting the current output, pulse output, and status output are 
hidden.
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Unit abbreviations and custom units E
E.1 Suggested custom unit labels and conversion factors

Table E-1 Custom volume flow units
Unit label (description) Conversion factor 

(out of m3/s)
Industry

ACFM (actual cubic feet per minute) 2118.88 Gas
ACFH (actual cubic feet per hour) 127133 Gas
MACFH (thousand actual cubic feet per hour) 127.1328 Gas
MMACFD (million actual cubic feet per day) 3.05119 Gas

Table E-2 Custom standard volume flow units
Unit label (description) Conversion factor 

(out of m3/s)
Industry

Sgal/min (standard US gallons per minute) 15850.3 Oil/Gas
Sgal/h (standard US gallons per hour) 951019 Oil/Gas
Si.gal/m (standard Imperial gallons per minute) 13198.2 Oil/Gas
Si.gal/h (standard Imperial gallons per hour) 791889 Oil/Gas
Sbbl/min (standard 42 US gal barrels per minute) 377.389 Oil
Sbbl/h (standard 42 US gal barrels per hour) 22643.319 Oil
Sbbl/d (standard 42 US gal barrels per day) 543439.651 Oil
SCFM (standard cubic feet per minute) 2118.88 Gas
SCFH (standard cubic feet per hour) 127132.80 Gas
MSCFH (thousand standard cubic feet per hour) 127.1328 Gas
MMSCFD (million standard cubic feet per day) 3.05119 Gas

Table E-3 Custom volume (totalizer) units
Unit label (description) Conversion factor 

(out of m3/s)
Industry

kgal (thousand US gallons) 0.264172 General
Mgal (million US gallons) 0.000264172 General
103m3 (thousand cubic meters) 0.001 General
Mm3 (million cubic meters) 0.000001 General
kft3 (thousand cubic feet) 0.0353147 General
Mft3 (million cubic feet) 0.0000353147 General
kyd3 (thousand cubic yards) 0.00130795 General

SITRANS FST020 IP65 (NEMA 4X)
Operating Instructions, 06/2024, A5E41425845-AD 139



Unit label (description) Conversion factor 
(out of m3/s)

Industry

af (acre-feet) 0.0008107140 General
ACF (actual cubic feet) 35.3147 Gas
MACF (thousand actual cubic feet) 0.0353147 Gas
MMACF (million actual cubic feet) 0.0000353147 Gas
Mbbl (thousand 42 gallon barrels) 0.00628981 Oil
MMbbl (million 42 gallon barrels) 0.00000628981 Oil
kbbl (thousand 42 gallon barrels) 0.00628981 Not Gas
Mbbl (million 42 gallon barrels) 0.00000628981 Not Gas

Table E-4 Custom std. volume (totalizer) units
Unit label (description) Conversion factor 

(out of m3/s)
Industry

kNm3 (thousand normal cubic meters) 0.001 General
MNm3 (million normal cubic meters) 0.000001 General
Sgal (standard US gallons) 264.172 Oil/Gas
kSgal (thousand tandard US gallons) 0.264172 Oil/Gas
Si.gal (standard Imperial gallons) 219.969 Oil/Gas
kSi.gal (thousand standard Imperial gallons) 0.219969 Oil/Gas
Sbbl (standard 42 US gal barrels) 6.28981 Oil
MSbbl (thousand standard 42 US gal barrels) 0.00628981 Oil
MMSbbl (million standard 42 US gal barrels) 0.00000628981 Oil
SCF (standard cubic feet) 35.3147 Gas
MSCF (thousand standard cubic feet) 0.0353147 Gas
MMSCF (million standard cubic feet) 0.0000353147 Gas

E.2 Unit abbreviations
Table E-5 Volume totalizer units
Unit abbrevia‐
tions

Unit descriptions

l liters
hl hectoliters
Ml million liters
m3 cubic meters
Mm3 million cubic meters
gal US gallons
Mgal million US gallons
i.gal imperial gallons
BBL31 barrels (1 barrel = 31 US gallons)

Unit abbreviations and custom units
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Unit abbrevia‐
tions

Unit descriptions

BBL42 barrels (1 barrel = 42 US gallons)
kBBL42 thousand barrels (1 barrel = 42 US gallons)
MBBL42 million barrels (1 barrel = 42 US gallons)
BBL31.5 barrels (1 barrel = 31.5 US gallons)
ft3 cubic feet
Mft3 million cubic feet
af acre-feet
in3 cubic inches
yd3 cubic yards
bush bushels

Table E-6 Standard volume totalizer units
Unit abbrevia‐
tions

Unit descriptions

Nl normal liters
Nm3 normal cubic meters
Sl standard liters
Sft3 standard cubic feet
Sm3 standard cubic meters

Table E-7 Mass totalizer units
Unit abbrevia‐
tions

Unit descriptions

g grams
kg kilograms
t tons
STon short tons
T long tons
oz ounces
lb pounds

Table E-8 Flow rate units
Unit abbrevia‐
tions

Unit descriptions

[Totalizer unit]/s per second
[Totalizer unit]/min per minute
[Totalizer unit]/h per hour
[Totalizer unit]/d per day
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Table E-9 Density units
Unit abbrevia‐
tions

Unit descriptions

μg/l micrograms per liter
μg/m³ micrograms per cubic meter
mg/l milligrams per liter
g/ml grams per milliliter
g/cm³ grams per cubic centimeters
g/l grams per liter
kg/l kilograms per liter
kg/m³ kilograms per cubic meter
lb/in³ pounds per cubic inch
lb/gal pounds per US gallon
lb/ft³ pounds per cubic foot
STon/yd³ STon per cubic yard (1 STon = 2000 lb)
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L
Lithium batteries

Safety, 17
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Mains supply, 30
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Process medium conditions, 100

P
Parameter view, 55
Power supply, 97

R
Return procedure, 78

S
Scope of delivery, 12
Sensor diagnostic events, 84
SensorFlash, 100
Service, 106
Service and support

Internet, 106
Service information, 76
SIMATIC PDM

functions and features, 131
menus, 133
parameters, 132

Support, 106
Support request, 106
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configuration, 81
device status, 81
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maintenance, 81
operating mode, 81
process value, 81

Symbols, (Refer to warning symbols)
System design, 99

T
Technical data, 97, 100

Current output, 98
Designated use, 99
Digital input, 98
Installation torques, 99
Interface, 97
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Power supply, 97
System design, 99

Technical support, 106
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Test certificates, 15
Transmitter

Wall mounting, 27
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